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PREFACE

Curry 8 is advanced software offering large amounts of functionality. It is described in detail in the Curry 8

User Guide and the Curry 8 Tutorials. In addition to the written documentation, this course is available. 

While the course covers many signal processing features of Curry, it does not detail the underlying

algorithms. As prerequisite knowledge, fundamentals of EEG analysis are necessary. 

Upcoming Events are listed on www.neuroscan.com and www.compumedics.com 
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FEATURES

CURRY integrates multiple complementary imaging modalities such as EEG, ECoG, MEG, MRI, 

fMRI, CT. By combining the latest techniques for determining electrical activity in the brain with 

anatomical and functional imaging, CURRY provides a powerful state-of-the-art method for accurately 

localizing the source of such activity. CURRY uses the full physical anatomy from MR and CT to 

provide three-dimensional models of the head and brain, pinpointing the site of activity. CURRY 

integrates fMRI functional imaging with EEG and MEG source analysis.

CURRY can be used on PCs and laptops running Windows 7 or later. It is aimed at functional mapping 

and diagnosis of brain activity. However, the functionality offered and the evolutionary nature of 

CURRY also make it suitable for wider application.

HIGHLIGHTS

� Modular design: buy the features you really need, upgrade easily.

� Integration of functional data (EEG, MEG, ECoG, sEEG, ECG, MCG) 

with image data (MRI, fMRI, CT, DTI FA, PET, SPECT).

� EEG data acquisition module with online processing capabilities.

� Complete data processing from filtering to source analysis.

� Event support, threshold and template-based event detection.

� Selective averaging (event type or SNR based).

� Artifact detection and reduction (subtraction and projection methods).

� Principal and Independent Component Analysis (PCA, ICA) and filtering.

� Time and frequency domain evaluations.

� Current Source Density (Laplacian).

� Individual realistic head models using Boundary and Finite Element Methods (BEM/FEM).

� Pre-computed realistic BEM head models.

� Dipole fits. Dipole confidence ellipsoids are computed. 

� Dipole scans, extended source (patch) scans, MUSIC and beamformer scans.

� Current density analysis, extended sources, Lp norms, sLORETA, SWARM.

� Sensor and source coherence, group statistics.

� Export of results in Excel, MATLAB, and SPM formats.

� Interface for data processing in MATLAB.

� Automation and batch processing.

� Report generator.

� Multi-core support using thread-based multitasking and parallelization.

� Hardware-accelerated real time rendering of 3D scenarios.

� Context-sensitive help system.

COMPUTER PLATFORMS

� PC with Windows 7 or later, Windows 10 64bit recommended for CURRY workstations. 

� Multi-Core processor recommended. 8+ GB RAM recommended. 

� Dedicated DirextX11 graphics card. 2 GB graphics card memory recommended. 

� Screen resolution 1920x1080 or more recommended. 

NOTES

4



Curry 8 Course – Epilepsy

INSTALLATION

The installation of CURRY 8 is similar to most other Windows based programs. You will receive an USB 

thumb-drive with an installer and a software lock (dongle).  

If you will be using Synamps or Nuamps amplifiers with the program, please use the following sequence for

the initial installation:

1. If the amplifiers are already connected to the computer, turn them off before installing the 

software. If they are not connected, leave them disconnected until you have installed the software 

(step 4). 

2. Connect the HASP dongle to a USB port.

3. Install the CURRY 8 software, including acquisition and amplifier drivers.

4. After installing the software, connect the USB cable from the System Unit to a USB2 port on the 

computer, and turn on the amplifiers. For 32 bit Operating Systems, Windows will find and install

the driver automatically. Confirm any popup windows that Windows displays. For Windows 7 64 

bit Operating Systems, the driver must be installed manually (see Installation Guide).

 Amplifiers must be switched off when connecting or disconnecting the USB cable.
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SHORT OVERVIEW OF FUNCTIONALITY

The following is a brief listing of the main functionality that is contained within CURRY.

MODULAR DESIGN

The more modules you use, the more you can do with CURRY. Modules are:

� X: Data Acquisition

� S: Signal Processing

� B: Basic Analysis

� A: Advanced Analysis

� D: Digitizer

� Add-On Modules: V: Synchroniced Video Recording

BCERT: Third party EEG and MEG file format readers

Missing modules can be purchased and activated later. Where applicable, the relevant modules are listed

with the feature descriptions below. 

USER INTERFACE

The entire functionality of CURRY 8 is made available through a highly interactive, configurable, 

single-layer, Windows-standard user interface. Predefined data import and data processing tasks allow 

for a workflow-based approach to data analysis. 

WORKFLOW

Workflow was formerly known as Tasks in the prior versions of CURRY. Workflow has undergone 

considerable development for CURRY 8, and it is now one of the main ways to help familiarize you 

with the program. It contains a number of tasks that you will want to complete. Selecting one will guide 

you to the relevant parts of the program.

DATABASE

All data files, result files, and configurations can be organized using a Database. This makes it possible 

to access multiple data files (functional data, anatomical data, digitizer files, results, study parameters) 

with a few mouse clicks.

FILE LOADING WIZARDS

CURRY will assist in loading data and digitizer files, and the co-registration of the files, using three 

'Wizards'.
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Functional Data Parameters Wizard
This part of the program is used to fill in undetected parameters or to modify parameters in the 

functional data files. It also lets you select which files to use for co-registering functional and 

anatomical landmarks. The outputs are two parameters files that are read when you subsequently 

load the data files, thereby bypassing the wizard. 

Digitizer File Wizard
The Digitizer File Wizard is used when your digitizer files cannot be interpreted accurately. Format 

modifications are made, and a file is created that contains information allowing CURRY to interpret

the columns in your digitizer file. This wizard writes a parameter file as well - containing the 

'column information'.

Image Parameter Wizard
This routine is used to assist CURRY in the loading and autodetection of parameters in the image 

data files. It is also used to specify the anatomical landmarks and Talairach landmarks and 

boundaries. The output is a parameter file that is read when you subsequently load the data file, 

thereby bypassing the wizard.

EEG DATA ACQUISITION (X)

CURRY works with all current Neuroscan and Compumedics amplifiers. It supports up to 512 channels 

(plus 16 bipolar and 8 high level channels) at up to 20kHz sampling rate. Extensive EEG display and 

processing options (filtering, artifact reduction, selective averaging, different sensor montages) are 

available during recording. EEG data acquisition is an optional module in CURRY. Most offline Signal 

Processing features are also available for online data processing.

SIGNAL PROCESSING (S)

After rereferencing, baseline correction, filtering, artifact detection and rejection, noise estimation, and 

selective averaging, CURRY can perform Principal (PCA, SVD) or Independent Component Analyses 

(ICA) to visualize the spatio-temporal features of EEG and MEG data. A full suite of event editing and 

detection tools is available. Template matching and threshold based event detection. Artifact reduction 

by subtraction and projection of averaged artifacts. Maps (equipotential contour lines), Source Current 

Density (Laplacians) and sensor coherences can be computed. Frequency domain analyses (FFT, Short 

Time FFT, Wavelets) are also possible.

INDIVIDUAL REALISTIC HEAD MODELS (A)

EEG signals and, to a smaller extent, MEG signals, are distorted by the electrically conducting head. 

CURRY can perform source reconstruction using the well-known spherical shell head models. 

However, one of its unique and powerful features is to create and use high-resolution realistic Boundary

Element Method (BEM) or Finite Element Method (FEM) head models based on anatomical 
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information. Such a realistic model derived from individual MRI (or CT) data increases the accuracy of 

source localization.

A built-in procedure performs fully automatic generation of the head model geometry (triangle nets) 

from T1-weighted MR images. A typical model consists of about 10.000 triangles.

PRE-COMPUTED REALISTIC HEAD MODELS (B)

CURRY also comes with high resolution pre-computed realistic head models that are applicable to all 

EEG data.

DIPOLE FITS (B)

Based on the measured EEG and/or MEG data, the sensor positions and the head model, a fit of one or 

more dipoles can be done. The position of the dipoles can be completely free (moving dipole) or can be 

restricted (rotating or fixed dipole, mirror or regional constraints). 

Dipoles can be computed in the time and in the frequency domain.

For each fitted dipole, a confidence ellipsoid is computed which visualizes the localization accuracy. 

Dipoles can be constrained to stay in the vicinity of a given location. Thus, it is possible to include prior

knowledge from imaging modalities such as fMRI, PET, or SPECT.

Dipoles can be fitted to individual ICA components, thus combining the decomposition power of the 

ICA with source modeling.

Dipoles can also be fitted according to the MUSIC (Multiple Signal Classification) metric. If more than 

one dipole is computed, the fit is performed sequentially (RAP-MUSIC). After finding a dipole, its 

impact on the data is projected out.

For multi-dipole fits, measures that can indicate whether too many dipoles were modeled are 

automatically computed. 

In addition to fitting dipoles, CURRY allows you to verify the dipole locations by performing, for 

example, dipole cross-validation, deviation scans, MUSIC scans, or current density analyses.

DIPOLE AND BEAMFORMER SCANS (A)

During a dipole scan, many locations are scanned sequentially. For each location, a measure is 

calculated for the possibility that a single dipole could account for the measured EEG or MEG signal (in

other words: would a dipole in this location explain the data?). The results from a dipole scan are 

independent from the results of a dipole fit. Therefore it provides additional and new information. If a 

dipole scan shows a single, sharp 'hot spot' that coincides with the location of a single dipole fit, the 
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assumption that the measured signal can be explained by a dipole in that location is confirmed. If, 

however, a dipole scan shows a smeared out pattern, the underlying single-dipole model may be wrong. 

A dipole scan is an alternative to confidence ellipsoids to visualize the confidence volume of a dipole. 

Dipole scans can be performed for one or more dipoles. Multi-dipole scans test dipole combinations. 

MUSIC scans allow for the detection of multiple independent sources.

Beamformer scans for dipole sources take raw data covariances into account. In CURRY, the g2 

(kurtosis) criterion for the detection of spikiness can be combined with beamforming.

Scans can be computed in the time and in the frequency domain. All scans can be performed for 

extended source patches instead of dipoles (point sources). 

CURRENT DENSITY RECONSTRUCTIONS (R,A)

A Current Density Reconstruction (CDR) is another independent analysis. It computes a current pattern 

on a regular 3D grid or the cortex that would explain the measured EEG or MEG at a certain time point. 

In a CDR, many source locations can be active simultaneously. In order to come up with a solution, 

additional assumptions are needed. For example: the minimum norm constraint (L1, Lp, or L2 norm), a 

maximum smoothness constraint (LORETA), and statistical measures (sLORETA, eLORETA, 

SWARM) can be applied.

All current density methods work with an automatic calibration of the regularization parameter lambda.

CDRs can be computed in the time and in the frequency domain. They can be performed for extended 

source patches instead of dipoles (point sources). CDRs can be computed for selected ICA and PCA 

components only. 

ANATOMICAL AND FUNCTIONAL CONSTRAINTS (A)

Both a scan and a CDR provide you with the possibility to use anatomical constraints. Brain activity 

usually originates from the gray matter (the surface of the cortex). Using that information as a constraint

improves your results.

A built-in procedure performs fully automatic segmentation of the gray matter geometry (triangle nets) 

using MRI data. 

fMRI, PET, or SPECT images can provide anatomo-functional constraints for dipole and current density

analysis. This is achieved by enhancing source probability in the vicinity of hotspots, or by seeding 

dipole fits from hotspot locations. 

To allow for an easy inclusion of functional images, a total of three image modalities with full co-

registration features are available.
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MEDICAL IMAGES (B)

CURRY reads all kinds of medical 3D image data. Parameters are detected from image files. Source 

analysis results can be overlaid with image data. 

IMAGE PROCESSING (A)

CURRY has powerful tools for processing medical 3D image data. Automatic co-registration, 

segmentation, morphological operations, and meshing are automated. Images from two or three 

modalities can be used simultaneously. 

WORKING WITHOUT INDIVIDUAL IMAGE DATA (B)

If no individual image data are available, CURRY automatically uses a built-in gross-average MRI data 

set. Alternatively, a single-subject data set, a pediatric averaged MRI, and an averaged MRI 

representing Asian headshape are also built into CURRY. 

TALAIRACH COORDINATES AND ATLAS SUPPORT (B)

By specifying AC, PC, and the brain extensions, results can be transformed into Talairach coordinates 

and extensive anatomical and functional atlas information (Brodmann areas) can be accessed.  Talairach

coordinates and atlas information are also available without individual image data.

STATISTICAL ANALYSIS (B)

CURRY uses advanced and robust nonparametric statistical tests to help you determine which 

conditions, latencies, and source analysis results are significantly different from each other.

DIGITIZATION (D)

CURRY supports the NDI Krios, NDI Polaris, Polhemus FasTrak and Polhemus Patriot digitizer 

systems.

VIEWING OF RESULTS

Results of dipole fits, scans, current density analyses and statistics can be viewed in 3D images and in 

2D images. Activation timecourses for dipoles and current densities can be displayed.

NOTES
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DOCUMENTATION OF RESULTS

CURRY provides logging to a window and to a file with selectable verbosity. A study logbook can 

automatically be stored with the data files. Extensive hardcopy features create image and avi movie files

in a variety of file formats. 

Computation results can be stored with the data files in CURRY’s own format, and Excel (csv), 

MATLAB, and SPM result files can be created. 

A built-in report generator allows you to create text documents on-the-fly.

FILE FORMATS AND COMPATIBILITY

CURRY reads a broad variety of EEG, MEG, digitizer, and image file formats. CURRY is backward 

compatible: It will read all legacy CURRY input files, as well as all CURRY 3 and later output files.

Supported EEG data formats include Neuroscan, Compumedics, BioSemi, BESA, BrainVision, EBS, 

EDF, EGI, Micromed, Bio-Logic, Stellate, XLTEK, Nervus, Nexstim, Nicolet, Nihon-Kohden, Persyst, 

Telefactor, raw binary and raw ASCII. 

Supported MEG data formats include Elekta Neuromag, Yokogawa, 4D-Neuroimaging (BTI), CTF, 

Philips, BESA, raw binary and raw ASCII. 

Supported image data formats include DICOM, NifTi, SPM, Analyze, Freesurfer, BrainVoyager, 

Siemens, GE, ACR-NEMA, JPEG, PNG, BMP, GIF, TIFF, raw binary and raw ASCII.
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USER INTERFACE

The following terms are used throughout this manual to identify different parts of the CURRY user 

interface:

The views have dynamic, context sensitive toolbars, that can be activated by moving the mouse cursor into 

the upper left corner of the view. 

NOTES

12



Curry 8 Course – Epilepsy

WORKING WITH CURRY

CURRY 8 contains an immense amount of functionality, and it is not likely that any one person will 

ever use all of it. Depending on the license you have, you might not even see all of it. This is not a 

program that you can master in a few hours or days, but it is possible to master the parts that you need in

a fairly short time. Perhaps the greatest challenge is learning the locations of the parts you need, while 

disregarding the other options that have no immediate use. 

As you learn more about the program you will find that there are frequently many options for 

accomplishing a single goal. For example, there are at least half a dozen ways to reduce eyeblink artifact

(with additional variations). There are more than a dozen ways to perform source reconstruction (with 

additional variations). You can create boundary element models entirely by hand, or have them created 

automatically. You will likely find that in several places you will not know which options to use. From 

our side, if there were a single method that always reduces eyeblinks, or a single best method for source 

reconstruction that applies in all cases, or ways that will automate whatever you want to do, we would 

have created the program in that way. However, there generally is no absolute best way to accomplish 

these and many other goals. In some instances, you may need to follow what others have published 

before, and we include whatever those options are. At times, you may need to do some trial and error to 

find the method that works best for your data files. Our goal, therefore, is to provide a variety of options 

so that you can determine which ones work best for you. We may make general recommendations about 

when to use which method, but it will always come down to what is most effective with your data. 

The user interface of CURRY is very similar to other applications running in the Windows operating 

system. We assume you are familiar with standard mouse functioning, resizing and repositioning 

windows, drop-down menu lists, giving the 'focus' to a window, and so forth. These universal operations

will not be described in and of themselves; they will be referred to as the need for the operations arise in

the documentation. For example, you may be directed to right click on a display to see additional 

options (context menu), or select an option from the drop-down list, etc. It is assumed that you are 

familiar with these types of operations.

FAMILIARIZATION WITH CURRY

When you first begin to use CURRY it is most helpful if you understand and follow the steps in the 

Workflow section. Workflow is accessed by clicking the tab typically seen in the lower left part of the 

display. Each section provides steps to follow, typically in the order they are completed. Click on an 

item in the list to go to that part of CURRY.
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In addition to the Workflow guide, there are multiple Tutorials below that will demonstrate various 

parts of the program. They are organized primarily into four main sections: EEG Acquisition, Signal 

Processing, Image Data Processing, and Source Reconstruction. There are additional tutorials for the 

Workflow, Database, Parameter Files, Substitutions, and the Macro Recorder. 

If you have a specific question about how to do something, like reduce eye blinks, you will probably 

find a Tutorial devoted to that. The Tutorials do not demonstrate every possible part of the program. If 

you do not find what you are looking for, try the User Guide.
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GLOBAL AND STUDY PARAMETERS

In prior versions of CURRY, these options were called Global and Study Defaults. In CURRY, these 

options have taken on further importance, and have therefore been renamed.

As mentioned previously, CURRY uses a different approach from our SCAN software, one that has 

been used in the CURRY program for many years. Instead of thinking about serial steps that are 

performed to analyze the data, think instead of a constellation of parameters, that is, all of the parameter

settings that are contained in the body of the program. Changes to the parameter settings are applied 

instantly in many cases. You do not have to create separate files along the way. If you have averaged 

data (such as EPs or averaged epileptic spikes), and you are doing source reconstruction, any changes to

make to the data files, the time range you are analyzing, the type of dipole analyses, and so forth are 

reflected immediately source results. At various points you may take a snapshot, so to speak, of all of 

the latest parameter settings (the Study Parameters) and save them with the Study you are working 

with. When you open that Study again, the parameters are applied, and you are then back where you 

were when the Study was last closed. You can take the Study Parameters used with one data file, and 

apply them to other like data files, thus reducing the duplication of effort. The result is a much faster 

and more efficient way to perform the analysis.

See the Using Parameter Files tutorial below for more information, as well as the CURRY 8 User 

Guide.

DATABASE

All input data that are processed by CURRY can be defined and structured using a Database. Database 

files do not contain the data files themselves, but rather point to the files on the hard drive (or external 

drive). You do not have to use databases, although you may find that they help organize the files you are

using.

Within Databases, data files are organized hierarchically. A Database can contain one or more 

Experiments (or none). Each Experiment can contain several Subjects (or none). Each Subject has one 

or more Studies. The Studies typically consist of the files you will be using, including functional data 

files, image data files, sensor position files, parameter files, and results files. Once specified, these will 

not have to be entered again for the same Study. See the Database tutorial for more information.

Each time CURRY is started, the Database window will appear with the previously opened Database. 

The open Database window is accessed at any time by clicking the Database tab from the row of tabs at

the bottom of the display .
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TYPES OF FILES IN CURRY

As you attempt various actions in the program, and as you read through the documentation, you will 

encounter many different types of files used with CURRY. In practice, you may or may not encounter 

all of them. For example, if you are using CURRY with Neuroscan average data files (.avg), performing

source reconstruction without a digitizer, and without the individual's own MR data, then the number of 

file types you encounter will be relatively limited.

If you have a digitizer to create the electrode and landmark positions (recommended), then you would 

use the .pom files created in the CURRY Acquisition module. If you have MR data, you may 

create .pom files (containing the anatomical landmark positions). BESA data have additional sensor 

position and optional label files to specify.

If you have magnetic data, there are montage files containing the coil array positions.

If you have prior versions of CURRY, and wish to use parameter files created by them, then you would 

encounter additional file types.

CURRY creates a number of its own parameter and derived image files (for segmentation, points, 

meshes, BEM models, etc.), and you will encounter these if you Save and Load the existing files.

The following summarizes most of the data files used with CURRY. This should become a convenient 

reference for you as you become familiar with the program. 

Functional Data Files

CURRY will read the displayed list of functional data files (EEG and MEG).
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Sensor Position and Landmark Files

These are the files that contain the XYZ coordinates of the electrode or coil positions and functional

landmarks. The CURRY Acquisition module produces a .pom file. Raw digitizer files have a .dig 

extension. Prior versions of CURRY produced .res and .rs3 files. BESA produces .eps, .elp, and

.ela (labels) files. 

Parameter Files

CURRY creates its own parameter files whenever you first load functional or image data. These 

files are then read when you reload the files subsequently, so the files do not have to be imported 

again. The various versions of CURRY produce .dap, .dpa, .imd, and .par parameter files (all read 

by CURRY). CTF creates .res4 and .hc files, which are read by CURRY.
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Image Data Files

CURRY will import the displayed image data files.

Image Data Derived Files

CURRY can produce .pom files that contain the structural data landmarks. It also creates various 

file types automatically, depending on the operations performed. Image parameter files have an

.imd extension. Image file names may have an .img extension. Isoimage data have an .iso 

extension. Surface meshes are labeled .s00...99. Segmentation results are labeled .bo0...99. Lists of 

points are labeled .sp0...9. BEM models are labeled bd0...29, bt0...29, and bm0..9.

Database-Related Files

In addition to the above data files, there are also files relating to the Database. CURRY Studies have

.cst extensions. Databases have either .mdb (CURRY 5, 6, 7 and 8) or .dba (CURRY 3 and 4) 

extensions. Results can have various extensions, depending upon the type of source localization that

was computed (.map, .ele, .dip, .dsc, .dsp, .cdr, and .cdp). Global Parameters are saved in the 

GlobalDefaults.cfg file. Study Parameters are saved in a user determined file (or a CURRY created 

file, such as Def20070222160044.cfg).

Graphics-Related Files

Graphics can be saved as .png, .bmp, .gif, .jpg, or .emf files. Movies, rotations, and slice 

progressions can be saved as .avi files.

For a complete list of files used with CURRY, see Appendix C in the CURRY 8 User Guide. 
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FUNCTIONAL DATA

Data from EEG and MEG measurements can be processed. The information can be visualized on a time 

axis. Basic viewing and functionality are offered. The functional data can be pre-processed by 

averaging, filtering, and artifact rejection, etc. Different channel (sensor) selections are possible for 

displaying data independent from its use for source reconstruction. This functionality is available by 

clicking the Functional Data tab . 

SENSOR POSITIONS

The functional EEG or MEG data are acquired by sensors. These are either electrodes or coil arrays. In 

both cases the positions of the sensors must be known. This means that the location of the electrodes or 

the geometry and location of the coils must be available in some arbitrary coordinate system. The x, y, z

position of each sensor is needed. For coils, the normals are also needed.

 EEG

For each set of measured EEG data the electrode positions must be known. Three methods are 

supported:

– Electrode locations are identified by their landmarks.

– A file provides locations, as measured by a digitizer. Landmarks are used to match these locations

to the coordinate system of the image data.

– Based on anatomical data the standard 10/20 or 10% electrode systems are generated. These are 

assumed to match the positions of the actual electrodes.

– Markers on the MR and CT can be used.

 MEG

In order to use MEG data the system geometry needs to be known. CURRY supports most MEG 

systems. The geometry is either read from the MEG data files, or taken from a predefined montage.

Digitizer and other similar files are specified in the Data Parameters, described below.

IMAGE DATA

Data such as MRI or CT show the anatomy of a subject, while fMRI or PET reveals brain activity. 

CURRY reads the data available in ACR-NEMA, DICOM, GE, Siemens, or plain binary formats. An 

autodetection feature scans the data set and derives as many of the image parameters as possible. This 

allows for an entire stack of image slices to be read and transformed into a 3D data set. 
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Image landmarks can be defined in the program. They are used to set up an internal coordinate system 

that is nasion- and preauricular point-based. This makes it possible to compare results between subjects 

and to perform registration between different image modalities.

From this point on, image viewing and processing are available. Objects such as the skin, the skull, or 

the cortex can be segmented manually, or with CURRY's automated segmentation routine, or a 

combination of both. Segmented objects are displayed as 3D images that allow visual inspection and 

volumetric measurement. On the surface of a segmented object, support points can be distributed and 

connected to form a triangular net or mesh. This net can then be visualized, saved, and used in other 

parts of CURRY.

Combining the EEG/MEG data with image data enables multimodal source localization. Image data are 

brought into CURRY’s coordinate system by specifying the nasion and the tragus points during data 

import.

SOURCE RECONSTRUCTION

Source reconstruction is about answering the question: where in the head is the origin of the activity that

generated the data measured at the scalp? The answer lies in solving two related problems. These are 

known as the forward and inverse problems.

Forward Problem

In the forward problem, the strength, location, and orientation of a source inside a head are known. 

The functional data that would be measured on the outside of the head, i.e., the field or potential 

distribution, are unknown.

The problem has a unique solution. Computing the solution requires information on sensor 

locations. The head is a head that distorts the potentials (or fields) of the impressed source, therefore

its shape and location dependent electrical conductivities need also to be known.

The very complex shape of a human head with all its anatomical details is represented by a 

simplified model. Its parts, such as the brain or the skull, are represented by different compartments,

with each compartment being assigned an electrical conductivity. The shape of these compartments 

is either spherical, or is derived from the actual shape of the head using anatomical data. The latter 

improves the accuracy of the solution to the forward problem.

 EEG

A three-shell realistic head model can significantly improve localization accuracy for EEG data, as 

compared to a one or two shell model. 
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 MEG

For MEG, the magnetic fields due to volume conduction effects are relatively small compared to the

magnetic field originating from the sources. A one-shell realistic head model defining the inside of 

the skull is normally adequate.

Inverse Problem

In the inverse problem, the signals on the outside of the head are known, while the source or sources

in the head are unknown. This problem does not have a unique solution. For each set of functional 

data an infinite number of sources or combination of sources generating the data can be found. The 

unlimited number of solutions is a fundamental problem of source localization, and additional 

information (constraints) is required to single out one solution. Specifying the type of sources 

representing the actual brain activity, the source models, is an important step in providing additional

information. Two different classes of source models are available, distributed and local sources. 

Distributed sources are found using current density methods, while local sources are computed by 

dipole fits.

 Care

Constraints are derived from the nature of the functional data and from your relevant experience. 

The type of source model, number of sources, as well as additional anatomical constraints to be 

included, have to be specified by the user before the inverse problem can be solved. Making 

assumptions not matching reality can lead to incorrect results.

Once the source model, the number of sources, and additional constraints have been established, the

inverse problem can be solved. The problem now has transformed into determining the parameters 

of the source model (e.g. locations and strengths). The solution of the forward problem based on 

these parameters matches the measured functional data as close as possible.

ACTIVITY

For time-consuming activities, the Status Bar shows the progress of the operation, and the mouse 

cursor will appear as an hourglass. If, during the program’s activity, further inputs are made, they will 

be handled as soon as the previous activity has ended, or ignored.

 Care

Repeatedly starting activities which require long processing times can lead to massive cumulative 

response times. In general, it is recommended that you let one processing step complete before selecting

the next one. 
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SAVING OPTIONS

Pay attention to the Save As dialogs when they appear. Often these contain important options that are 

not available elsewhere. For example, when you create an averaged data file offline and save it, you will

see several options:

Upsample/Downsample is the CURRY option for Decimation or for Spline Fitting (as it was called in 

the SCAN software). You have the option to save just the Timerange designated between the two outer 

cursors (Save Selected Interval), or the entire Timerange. There is also the option to include the results 

at various positions in the Database. You can open the study with the new file immediately after saving, 

and execute a macro upon opening it (to automate analysis).

Similarly, when saving source reconstruction results, there is an option to Memorize the filename in the 

current Study. When enabled, the results file(s) will be added to and be accessible from that Study.

LOGGING FACILITIES

CURRY has extensive logging facilities. Results, messages and warnings are written to the Output 

window. (In the figure below, the Output window is shown after a Moving Dipole fit). 
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The output results from each session with CURRY are logged automatically in a .txt file. A file name is 

created automatically, such as . This is a combination of the year\month\day\time. An 

example of a session log is shown below.

Right click in the display and see the Open In Editor option, which opens the file in a text editor, and 

the Open File Location option, which will take you to the folder containing the log files.

Additional logging facilities include Study Logbooks and the macros. See the History Options section in

the CURRY User Guide for a fuller explanation.

OBTAINING HELP

Two electronic manuals are supplied with CURRY: Installation and Tutorials and the User Guide. 

Generally speaking, the Tutorials demonstrate how to perform certain operations, such as, reducing 

artifacts, computing dipoles, etc., while the User Guide has more basic details of each component of 

CURRY.

Context sensitive Help is available by positioning the mouse in the desired position on the screen, such 

as in a parameter panel, and then pressing the F1 key on the keyboard. The corresponding section of the 

User Guide will be displayed.  

For additional help, contact Technical Support (CURRY8help@neuroscan.com), or call one of the 

phone numbers listed under Contact Information above. From the Help options, select Check for 
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Updates to search the web site for any updated versions of CURRY. The manuals are accessed in either 

the standard compiles help manual format (.chm) or in PDF format, which is better for printing. If you 

are having a problem and wish to send a screen shot to the CURRY Helpdesk, select Send E-mail to 

Helpdesk. This will connect to your e-mail program, and automatically include the current screen shot, 

as well as program version and system information that may help diagnose the problem. The About 

CURRY option displays version information for CURRY and the modules it is using.

PERFORMANCE

CURRY allows you to perform very complex actions on large amounts of data. For that reason, it only 

runs satisfactorily on fast computers with large amounts of internal memory.

Processing Speed

For some operations complex algorithms are used repeatedly, e.g., for each point on a surface. They 

may take several minutes for completion. This applies to, for example, the initialization of a realistic

head model (BEM), the first dipole fit done with a new head model, and the computation of a scan 

or a current density analysis. The initialization has to be performed only once per subject.

Video Drivers

CURRY uses advanced methods for graphics presentation. We strongly recommend that you update 

your video drivers to avoid display problems (determine your video card, and go to the 

manufacturer's web site for updated drivers). Most vendors only provide hardware acceleration for 

32 bit (desktop) color depth. If you're running 16 bit, the system will revert back to generic software

emulation. 32 bit is recommended. 

Memory

Large amounts of internal memory are needed for processing large time ranges of EEG/MEG data 

or for performing source analysis on many source locations. In order to see how much of your 

computer's memory is in use, open the Task Manager by pressing Ctrl-Alt-Delete and switch to the 

Performance tab. The installed RAM is shown as Physical Memory: Total, while the largest amount 

of memory actually used since the last boot is shown as Commit Charge: Peak. If this value is 

higher than the installed RAM, the computer uses a technique called swapping, which decreases 

performance by a factor of 10 to 100. Note, however, that the maximum amount of RAM that can be

used by a 32 bit program such as CURRY is approximately 3GB. For 64 bit operating systems, it is 

limited by the amount of RAM available in your computer.

Computation Time

Bear in mind that computing times depend on: the amount of information processed, the available 

amount of free memory, the type of processor.
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USER INTERFACE CONCEPTS AND CONVENTIONS

START CURRY

� Start CURRY: double-click the CURRY 8 icon    

CURRY 8 consists of five main modules:

X: Data Acquisition

S: Signal Processing

B: Basic Analysis

A: Advanced Analysis

D: Digitizer

All meaningful permutations of these modules are presented in the CURRY 8 Launcher:

The appearance of CURRY 8 depends on which modules are loaded. This is determined by the 

version of CURRY 8 that gets loaded and the licenses available on the dongle. For example if 

CURRY 8 XSB is loaded with a dongle that contains an S, B and A license, CURRY 8 SB will be 

started.

NOTES

25



Curry 8 Course – Epilepsy

OPEN A FILE

� From the File menu, select Open..., or click  in the toolbar.

� Select C:\CURRY 8 Course\Signal Processing\Blink Reduction\Viscpt.cnt

� Press Open.

� CURRY 8 supports a variety of EEG, MEG, and other file formats (see chapter Types Of Files in 

CURRY). CURRY 8 should have write-access to the folder of the data file to be able to store 

additional information. 
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PARAMETER PANES AND DIALOGS

A Dialog contains parameters that can effect the data, the view on the data, or trigger actions to 

process the data. 

Dialogs are organized in Parameter Panes. Each Parameter Pane contains several dialogs that all 

apply to a certain task (Functional Data handling, Image Data handling, Source Reconstruction, etc.). 

Within a Parameter Pane the dialogs are sorted in a top-to-bottom manner, representing a typical 

work flow for the dedicated task of the Parameter Pane they are in. The number of Parameter Panes 

depend on which modules CURRY has been started with.

� Switch between Parameter Panes. Note how the dialogs exchange.

Hover your mouse over the icons to see the full name in a tooltip window

� Click + and add the Maps Parameter Pane.

� Click on the Maps Parameter Pane tab with the middle mouse button to hide it.

� In the Functional Data Parameter Pane, click + next to Channel Groups / Bad Blocks and 

Add Referencing to the data processing sequence.

� In the Referencing dialog, select EEG: <CAR>
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Note that the label of the Referencing dialog becomes bold to indicate a change of the default 

parameters.

� Click + next to Referencing and Add Filtering

� Set Filter Type: Alpha-Band
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� Click on    and set Filter-Type to IIR zero phase

� Expand Options and set Max. Disp. Channels to 10

Note that the label of the dialog does not become bold, because this option only changes the view to 

the data, not the data itself.

� Uncheck the checkmark in front of Referencing or click + and Remove to delete a processing 

step.

� CURRY 8 processes the currently visible data page immediately when a parameter changes.

� Some dialog contain  buttons (caption varies). They expand or hide additional options that 

typically are less common, or don't need to be changed frequently.
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DISPLAYS AND VIEWS

The Display Tabs define which views are visible. Like the Parameter Panes, the number and content 

of the Display Tabs depend on which modules of CURRY are loaded.

� Click + and add the Maps display.

Note that the Parameter Pane has switched to Maps/PCA. The icons of the Display matches the icon 

of the Parameters.

� Under Maps/Contour Lines, select Maps: Off.

� Switch between the Display Tabs to see all available views.

� Click onto a view tap (such as Maps) with the middle mouse button to hide it.

� Switching Display tabs does not change your data. It switches the Parameter Pane to show options 

that apply to the current view. Some displays contain multiple views.
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� Select the Display Tab All

� Move your mouse to the top-right corner of the Functional Data waveform view to make the 

Expand Button appear.

� Press the Expand Button to view the waveforms in fullscreen. 

� Press the Expand Button again to revert.

� Move your mouse to the top-left corner of  each of the views to access their view specific 

toolbars.

 

� In the waveform view, move your mouse onto the label FP1.

Note that the mouse cursor changes its shape.

� Right-click onto the label of FP1 to view its channel specific options in a context sensitive menu.

� Now Right-click into the waveforms to view the waveform specific options.

          

� Context sensitive menus are used throughout CURRY 8 and can always be accessed by clicking the 

right mouse button. Options with icons can be found in a toolbar as well. Some options are also 

accessible through keyboard shortcuts (such as Alt+B to switch to a Butterfly Plot).
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� Click and drag the dividers between views to change the size of each view.

� Click and drag the header of a dialog from the Parameter Pane to detach it.

� Click the X to reattach the dialog to the Parameter Pane

� Use View → Reset Window Layout... to reset the User Interface to the default values (don't 

restart CURRY).
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THE WORKFLOW

� Select Workflow from the Parameter area.

� Click on Signal Processing >   to get to the reference dialog.

� Set the reference to <Off>.

� Note how the Workflow item changes to .

� The Workflow provides easy access to frequently used options or actions. Its items are grouped by 

their scope of application and depend on the current state of the software (for example you will only 

see advanced Image Data options when an image data set has been loaded). 

  Parameter has been set, or no action is necessary

Parameter should be reviewed

Some entries show basic information about selected parameters, such as .
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OBTAINING HELP

Besides the Workflow, CURRY contains features that are designed to help you understand 

parameters and explore CURRY.

� Move your mouse to the  icon in the Functional Data view toolbar.

�

The CURRY User Guide appears, showing the appropriate page.

� You can find all documentation that comes with CURRY in the Help menu.

Use Check for Updates... to look for the latest official version of CURRY 8.

Use Send Email to Helpdesk (curry  8  help@neuroscan.com  ) to get in contact with the CURRY 

developers for additional support.
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EXAMPLE DATABASE
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1 EEG MRI

EEG: single spike, 28 channels, 200Hz sampling rate, digitized electrode and landmark positions

MRI: T1-weighted, 256 x 256 pixels (0.918mm x 0.918mm), 124 axial slices (2.0mm)

Left Temporal Lobe activity / Spherical versus BEM Head Model
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2 MEG EEG (MRI)

4D

MEG: 248 magnetometers, EEG: 26 electrodes, 678Hz sampling rate, digitized electrode and landmark 

positions, 4 spike events averaged

MRI:  T1-weighted, 256 x 256 pixels (0.898mm x 0.898mm), 180 sagittal slices (1.0mm)

Right Temporal Lobe activity / MEG versus EEG
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Elekta

MEG: 303 magneto-/gradio-meters, EEG: 60 electrodes, 1000Hz sampling rate, digitized electrode and 

landmark positions, ongoing data, 6 bad blocks, frequent spikes

Left Temporal Lobe activity / Template matching / Dipole clusters / MEG versus EEG
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3 ECOG MRI CT PET

ECoG: several spikes, 8x8 grid, 200Hz sampling rate

MRI:   T1-weighted, 256 x 256 pixels (1.016mm x 1.016mm), 114 axial slices (1.6mm)

CT:     512 x 512 pixels (0.488mm x 0.488mm), 505 axial slices (0.5mm)

PET:   128 x 128 pixels (2.059mm x 2.059mm), 63 axial slices (2.425mm) 

Co-Registration MRI / CT / PET, grid electrodes from CT, overlay with cortical surface from MRI
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4 SEEG MRI CT

sEEG: ongoing data, 153 channels, 1000Hz sampling rate

MRI:   T1-weighted, 384 x 384 pixels (0.599mm x 0.599mm), 200 axial slices (0.8mm)

CT:     512 x 512 pixels (0.475mm x 0.475mm), 181 axial slices (1.0mm)

Co-Registration MRI / CT, electrode positions from CT, overlay with cortical surface from MRI
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5 MRI DTI

MRI:   T1-weighted, 256 x 256 pixels (0.937mm x 0.937mm), 256 axial slices (1.0mm)

DTI:    128 x 128 pixels (1.875mm x 1.875mm), 40 axial slices (3.8mm)

Co-Registration MRI / DTI, colored overlay of fiber orientation
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6 L/R SPIKES

EEG: ongoing data, 26 channels, 200Hz sampling rate

Template matching, Dipole Clusters, no MRI
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PATIENT DATA AND DATABASE ORGANIZATION 

DATA ORGANIZATION

Use a structured approach to physically store your data:

� one folder per patient (use patient name as folder name)

� subfolders for image data (MRI, CT, PET, SPECT, etc) and 

� subfolders for functional data (scalp EEG, intracranial data, etc)

DATABASE ORGANIZATION

� one subject  per patient

� image data  stored on patient level

� study folders  per functional data file 

� optionally, use patient groups  to organize patient data

� create database in the folder where the data are stored

     
Windows folder structure        Curry database structure

� The Curry database allows you to organize your data for quick access. 

The database stores references to files on your file system. It does not store the data themselves.
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WORKING WITH THE DATABASE

There are various ways to setup a database and insert data:

� From the Database menu, select New… to create or Open… to access an existing database.

� Use the Add Experiment button  to insert a patient group.

� Use the Add Subject button  to insert a patient.

� Use the Add Study button  to insert a study.

� Drag files from Windows explorer into the database.

� Right-click a patient  or study  and select one of the Insert options.

� Drag files or studies within the database.

� To see the path of a data file, move the mouse over that file, or

press the Show Full Path button .

To work with data in Curry, you need to open a study:

� Click the Open Study button , or

Double-click the study  or the data file , or

Right-click the study  and select Open.

� To quickly access a file, you do not need the database. Just go to the File menu and select Open 

File… or Open Folder...
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INTER-ICTAL EPILEPSY DATA ANALYSIS

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Interictal EEG and Scalp Data.

� To use this study: click the Open Study button  next to Scalp Data or

double-click Scalp Data or 

right-click Scalp Data and select Open.

� The database is only one way to access data files. 

Files can also be opened via the Open File button  or the Open Folder button  .

� All example data used in this course are located in the folder 

C:\Curry 8 Course\Epilepsy.
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DATA WINDOW

EEG waveforms can be seen in the Functional Data display, together with channel labels and vertical 

time and event markers. Find out about data display, scaling, and navigation:

� From the Functional Data menu, select Show Information…. 

� Close the Functional Data Information window.

� In the Options dialog, change the Pagesize to 5s.

� Use the slider below the data display to navigate through the data file. 

Alternatively, use the Page Up and Page Down keys and Shift + Page Up/Down, 

or the navigation toolbar buttons  that appear if you move the mouse cursor to the

upper left corner of the Functional Data view.

� From the Functional Data menu, select Autoscale or press the  toolbar button.

� Deselect and reselect Display Time in the Options dialog. Time can be shown as wall clock time 

or in seconds.

� Data are a 30-minute segment of ongoing LTM Epilepsy sleep data. Curry reads most raw LTM data 

file formats. Often, interesting segments of data are exported from the LTM system for further 

processing with Curry.
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CHANNEL SELECTION 

Identify and deselect bad channels:

� Click the  sign on the right of the   parameters and press the

 button (or click  from Workflow / Signal Processing). 

Make sure Reference is <Off>.

� Click the  sign on the right of the   parameters and press the

 button (or press  from Workflow / Signal Processing). 

Open the parameters (use ctrl-click to see more than one parameter dialog),

� Switch Baseline Correction from Off to Constant.

� Scroll through the data and identify bad channels. To deselect a channel, click its channel label.

� To hide deselected channels, go to  and uncheck Show Deselected Channels.

� To re-select all channels, open the Functional Data menu or right-click in the data display and 

choose Select All Channels. Alternatively, press Ctrl-S. 

� In  , switch the reference to <CAR>.

� Use an unreferenced data display and baseline correction to assess bad channels.

A common average reference (CAR) guarantees easily interpretable contour maps with positivities 

and negativities and enables source analysis.
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FILTERING AND STUDY PARAMETERS

Before reviewing data, adjust filter settings and save study parameters:

� Click the  sign on the right of the  and press   

to insert the Filtering dialog (or press  from Workflow / Signal Processing).

� Switch the Filter Type from Off to User Defined (Auto). In this mode, filter slopes are 

automatically adjusted to match the filter cutoff frequencies.

� To save these adjustments, open the File menu and select Parameters and Save Study 

Parameters, or press the Save Study Parameters toolbar button .

Accept the suggested filename and press Save.

� A High Pass filter with a cutoff frequency of 1 to 2Hz ensures that waveforms do not exhibit low-

frequency fluctuations.

A Low Pass filter removes EMG and other high-frequency artifacts. If no low pass filter is used or if 

its cutoff frequency is higher than the mains frequency (60 or 50Hz), a Notch Filter may be needed. 

� Study Parameters are stored in the database and are applied whenever the study is opened. They are 

a way to make channel selection and filter settings permanent without modifying the actual data file.
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MONTAGES

It is possible to display waveforms using a montage:

� Open  and change the Montage from <None> to Longitudinal Referential. 

The order of EEG waveforms and labels changes.

� Change the Montage to Longitudinal Bipolar. 

EEG waveforms and labels change.

� Navigate to second 202, (or enter 202000 as the Cursor Latency), where at 3:22:000 you can 

observe a polarity reversal in the left frontotemporal channels.

� Curry comes with a variety of predefined montages. 

The available montage types are referential (reordering) and bipolar (differential).

NOTES

49



Curry 8 Course – Epilepsy

MONTAGE EDITOR

A montage editor allows to define custom montages:

� From Montages, select <New…>.

� Choose a New montage name and press OK. The Montage Editor window appears.

� In the montage editor, 

double-click a channel to create a monopolar trace (for referential montages)

drag a line between channels to create a bipolar trace (for bipolar montages)

click Add Empty to insert a gap, 

edit any label in the montage table to reference other channels such as EKG, 

drag the black triangle in the left, gray area of the montage table to reorder entries.

� Press the Save the current montage with a new name button  if you wish to rename the 

montage, or press the Save the current montage button  and OK or just press OK to save and 

use the montage.

� From Montages, select <None> in order to see the original channel waveforms.

� User-defined montages can be reused for a variety of data files. 

When a montage is applied, Curry matches channels labels to labels that appear in the montage.  
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CHANNEL HIGHLIGHTING

When reviewing data, it can make sense to highlight individual channels:

� Move the mouse over the T7-avg channel label in the data display and use the mouse wheel to 

change channel scaling, or right-click the T7 channel label and select Zoom Channel x2. 

Modified waveforms are displayed in bold.

� Right-click the T7 channel label and select Channel Color…. Change the color to Dark Red.

� (to reset, right-click the T7 channel label and select Reset)

� To update study parameters, press the Save Study Parameters toolbar button  again. 

The already existing study parameter file is updated.

� In the T7 channel, left temporal spikes and slow waves are visible. 
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MANUAL SPIKE MARKING

During data review, spikes can be marked using the cursor and the number keys on the keyboard.

� Press the -tab or the Open Events   icon in the Functional Data tab to display 

the Events / Epochs-tab instead of the database.

� Check Manual and set Auto-Align to T7: 

This prepares Curry for manual spike marking based on voltage peaks in T7.

� From the Functional Data menu, select Edit Event Annotations….

When marking spikes, each number key on the keyboard corresponds to an annotation.

� Shift-double-click (switch to a single-latency time cursor) and drag the cursor to the peak of a 

spike in T7, for example the one at 3:22.000. Dragging the mouse will snap to T7’s voltage peaks.

� Press the number key 1 (one). The corresponding annotation (“Spike 1”) appears at the top of the 

data display and a colored area indicates the marked spike. 

� The width of the colored area can be controlled via the Pre and Post latencies in the Event List. 

Change Pre and Post to -1000 and 1000 ms, respectively.

� Indices in the eventlist can be displayed: Right-click into the list and select .

� Page using (Shift-)Page Down, or select  from the context menu click 

spikes in T7, press '1' for ~15 events (Shift and Mousewheel will advance by 1/10 pages).

� Events appear as colored marks at the bottom of the data display, just above the time slider.

NOTES

52



Curry 8 Course – Epilepsy

SPIKE REVIEW AND CLASSIFICATION

Spikes can now be reviewed and classified:

� Double-Click the first entry in the Event List. The first manually marked spike is displayed. 

� Above the data display, switch to .

� With the  in the Maps / Contour lines-UI (Maps-tab) the appearance of 

the map display can be changed.

� To review events using the Event List, use the Cursor up and down keys. 

Events can be deleted by pressing the Delete key or via the context menu (right click)

The spike type can be changed using Ctrl and the number keys 1,2,3,... on the keyboard.

� To review events from the data display, use the event navigation tool bar buttons  or 

the corresponding keyboard shortcuts Shift+Cursor left/right and Ctrl-E to delete. 

The spike type can be changed by pressing Ctrl and a number key on the keyboard.

Use the Cursor left/right keys to explore propagation by looking at map changes.

� When navigating from one event to the next, relative cursor positions are maintained. 

To center the selected event on the page, double-click in the Event List
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SPIKE SORTING AND SAVING 

Spikes can now be sorted according to type and saved:

� Above the Event List, change the Type to m1.

Press the heading button 2 and change the Type to m2.

Press the heading button 3 and change the Type to m3, etc.

Spikes are now sorted into event groups according to their type. 

� In the Event / Epochs toolbar, press the Save Events button . 

The Save Event List window appears.

� The data filename is suggested as the event filename. If this filename is used by pressing Save, 

events will automatically be loaded when the data file is opened next. 

If another filename is used, events can later be loaded using the Load Events button .

� Press Save.

� Sorting events allows to create event-specific averages later on.
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SPIKE AVERAGING 

Spikes are averaged according to their type.

� Below the Event List, press the  button. 

The data display changes and the average of spike type 1 appears (see upper right of data 

display).

Using the slider below the data display, the other averages can be selected. The peak is at 0ms.

� Press the Butterfly Plot toolbar button . Waveforms are overlaid.

� In the Functional Data tab, open the  dialog.

� Change the Method to User Defined Interval and use a Time Range from -1000 to -100ms.

� To save these spike averages, go to the Functional Data menu and select Save and Save Data.

� Below the Event List, press the  button in order to revert to the continuous 

data. 

� Adjustments in Noise Estimation need to be made because 0ms is not the beginning but the peak of 

the data.
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SPIKE EPOCHING 

It is also possible to save all identified spikes to an epoched file.

� In the Event / Epochs toolbar, press the Export Epochs button . 

The Save Events window appears.

� Check Open as New Study, click Show Options and check Add File to Database, Add to 

Study as.

� Press Save. 

Data are saved and directly opened as a new study, which also appears in the database.

Using the slider below the data display, the individual spikes can be selected. 

The spike type appears in the upper right of the data display.

Again, the 0ms latency indicates the peak of the spike.

� Press the Butterfly Plot toolbar button . Waveforms are overlaid.

� Press the Close Study button  or press Ctrl-F4. The original study appears.

� Using an epoched file, source analysis can later be performed per individual spike, which allows 

spike clustering. Again, the noise time range must be adjusted in order to not interpret the peak as 

noise.
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AUTOMATIC SPIKE DETECTION BY TEMPLATE MATCHING

We want to find occurrences of a marked spike automatically throughout the data file.

� In the Event List, double-click spike at 03:22.000. The spike is centered in the display.

� Change the two outer time cursors to only enclose the spike and slow wave. 

� In the Functional Data parameters tab click the  sign on the right of the

 and click  to append the corresponding 

functionality (or press  from Workflow / Signal Processing).

� Change the Template Channel to T7. The template waveform is defined.

� Press the blinking Scan Artifacts / Templates  icon. Data are scanned for matches. 

� Above the Event List, switch the Type to tmpl1.

� In the  dialog, lower Amplitude and Correlation limits both to 70% 

in order to see more matches.

� Automatically found spikes are now ready for reviewing, averaging, epoching, etc.

� For template matching to work well, the template waveform should have at least two zero-crossings. 

Templates can be found more reliably when using a high pass filter of 1 or 2Hz. 

For tmpl events, the 0ms timepoint marks the beginning of the template, not the peak.
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SPIKE AVERAGING

We want to average the spikes found by template matching.

� In the Event List, select Type tmlp1 in the first tab, deselect the other tabs.

� Set Pre and Post latencies in the Event List to -1000 and 1000 ms, respectively

� Below the Event List, press the Average All Event Groups (in-place) button

. The data display changes and the average of the spikes appears.

� If not already done, display the potential map at the cursor latency by clicking the -tab

� Fit a single moving dipole by selecting Dipole Type: Moving in the -tab

� Click  button in order to display the original data.
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ICTAL EPILEPSY DATA ANALYSIS

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Ictal EEG and Seizure.

� To use this study: click the Open Study button  next to Seizure or

double-click Seizure or 

right-click Seizure and select Open.

The Functional Data Import window appears

� The database is only one way to access data files. 

Files can also be opened via the Open File button  or the Open Folder button .

� All example data used in this course are located in the folder C:\Curry 8 Course\Epilepsy.
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DATA PARAMETERS

Make sure the file is identified correctly:

� Review the File Name, Format, Sample Rate, number of Channels, etc.

� Scroll through the list and see which channels have been assigned as EEG and Other channels. 

The distinction is made based on the Move unknown Labels to “Others” group setting. 

� Press Next.

� When a file is loaded for the first time and some information is missing (usually, the electrode 

locations), the Functional Data Import window opens. 

Data are in Compumedics ProFusion EEG 4 file format, which uses a folder to store data. 

In Curry, this is indicated by the appended letters <dir>.

� The Functional Data Import window also allows to separate channels into channel groups such as 

EEG and Others. Channels with a meaningful location that can be used for source analysis are EEG.

Everything else (EKG, ocular channels, etc) is Other.
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DATA PARAMETERS (CONT’D)

Specify electrode locations:

� Review the electrode location list. 

Just above the list, the number of electrodes and landmarks appears, together with the method 

used for determining electrode locations.

Note that Use Label-Matching to determine Positions is checked. 

� Press Finish. Data appear in Curry.

� If electrode locations have been measured using a 3D pointing device such as the Polhemus Fastrak 

digitizer, a file with electrode and landmark locations is available. Such a digitizer file can be 

accessed by switching Get Positions and Labels from to External Digitizer File..
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CHANNEL SELECTION 

Identify and deselect bad channels:

� Click the  sign on the right of the   parameters and press the

 button (or press  from Workflow / Signal Processing).

� Open the parameters and switch Baseline Correction to Constant.

� Press the Autoscale toolbar button .

� In the Options dialog, select .

� Scroll through the data and identify bad channels. 

� Deselect channel C4 by clicking its label.

� Also deselect channels LArm, Lleg, RArm, RLeg, Back, and Trigger.

� To hide deselected channels, go to  and uncheck .

� Click the  sign on the right of the   parameters and press the

 button (or click  from Workflow / Signal Processing).

� In  switch reference to Common Average Reference <CAR>.

� Use an unreferenced data display and baseline correction to assess bad channels.

NOTES

62



Curry 8 Course – Epilepsy

FILTERING, PAGESIZE, AND STUDY PARAMETERS

Before reviewing data, adjust filter settings and save study parameters:

� Click the  sign on the right of the  and press  to 

insert the Filtering dialog (or press  from Workflow / Signal Processing).

� Switch the Filter Type from Off to User Defined (Auto). 

� Adjust the Low Pass filter so that data are filtered from 1 to 20Hz.

� In the Options dialog, change the Pagesize to 5s.

� To save these adjustments, open the File menu and select Parameters and Save Study 

Parameters, or press the Save Study Parameters toolbar button .

Accept the suggested filename and press Save.

� A High Pass filter with a cutoff frequency of 1 to 2Hz ensures that waveforms do not exhibit low-

frequency fluctuations.

A Low Pass filter removes EMG and other high-frequency artifacts. If no low pass filter is used or if 

its cutoff frequency is higher than the mains frequency (60 or 50Hz), a Notch Filter may be needed. 

For seizure analysis, low pass frequencies around 20Hz are often appropriate.
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BEGINNING OF SEIZURE AND CHANNEL HIGHLIGHTING

We want to analyze data at the beginning of the seizure, in order to capture the seizure origin:

� Navigate to 07:59:57, where voltages are starting to build up and rhythmic activity in channels 

F9, F7, T1 can be observed.

� Right-click the T1 channel label and select Channel Color…. Change the color to Red and 

Linewidth to 2 (to reset, right-click the T1 channel label and select Reset).

� To update study parameters, press the Save Study Parameters toolbar button  again. 

The already existing study parameter file is updated.

� In the Frequency Domain roll-up, select Short-Time-FFT STFFT for channel T1, adjust 

Resolution to 512ms and Max. Freq. to 15.6Hz, switch to Butterfly-plot and review the seizure 

onset oscillations around 6.7Hz.

� In the T1 channel, rhythmic activity is best visible. 

For some data files, identification of rhythmic patterns is easier with Reference switched to <Off>.

The peaks of the rhythmic activity can be used for source analysis.
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MANUAL PEAK MARKING

Peaks can be marked using the cursor and the number keys on the keyboard.

� Press the -tab or the Open Events   icon in the Functional Data tab to display the 

Events / Epochs-tab instead of the database.

� Check Manual and set Auto-Align to T1. 

This prepares Curry for manual peak marking based on channel T1.

� From the Functional Data menu, select (and close) Edit Event Annotations….

� Switch Butterfly-plot and STFFT off.

� Click and drag the cursor to a negative (upwards) peak in T1, such as 07:59:57.270. 

� Press the number key 4 (four). The corresponding annotation (“Seizure”) appears at the top of the

data display and a colored area indicates the marked spike. 

� Change its width by using Pre and Post latencies of -100 and 100ms in the Event List.

� Mark other peaks on the same page of data. Repeat for ca. 10 events.

Correct peak location by using the Cursor left/right keys if necessary.

Avoid peaks with ocular artifacts (see LOC, ROC, and frontal channels).

� Events appear as colored marks at the bottom of the data display, just above the time slider. 
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PEAK REVIEW  

Peaks can now be reviewed:

� Double-click the first entry in the Event List. The first manually marked peak is displayed in the 

center of the page. 

� Above the data display, switch to .

� To review peaks using the Event List, use the tool bar buttons  or Cursor up / down keys.

� Events can be deleted by pressing the Delete key or by clicking  from the toolbar.

� To review events from the data display, use the event navigation tool bar buttons  or the 

corresponding keyboard shortcuts Shift+Cursor left/right and Delete to delete.

� When navigating from one event to the next, relative cursor positions are maintained. 

To center the corresponding event on the displayed page, double-click in the Event List.
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PEAK SAVING 

Peaks can now be saved, averaged, and epoched similar to spikes:

� In the Event / Epochs toolbar, press the Save Events button . 

The Save Event List window appears.

� The data filename is suggested as the event filename (make sure it is Seizure.eeg.cef). 

If this filename is used by pressing Save, events will be loaded with the data file. 

If another filename is used, events can later be loaded using the Load Events button .

� Press Save.
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PEAK AVERAGING 

Peaks can now be averaged and saved.

� Below the Event List, press the  button .

� Press the Butterfly Plot toolbar button . Waveforms are overlaid.

� Open the  dialog and change the Method to Percentile 20.

� To save these spike averages, go to the Functional Data menu and select Save and Save Data…

� Click  in the Display tabs and fit a moving dipole by selecting Dipole Type: Moving under

Dipole Fit in the Source Reconstruction tab.

� Below the Event List, press the  button to revert to the unaveraged data. 

� Adjustments in baseline correction and noise estimation need to be made if 0ms is not the 

beginning but the peak of the data. The Percentile 50 method (or a User Defined Noise Level) are 

used if no signal-free latency can be identified.
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ICA-DECOMPOSITION OF THE SEIZURE ONSET 

Select a timerange containing the seizure onset and perform an Independent Component Analysis 

(ICA) in order to identify the map corresponding to the 6-7Hz oscillations.

� Switch to  display.

� Select a timerange from 07:59:56.960 to 07:59:58.700 containing the onset of the oscillations in 

channel T1.

� In the Maps-parameters, PCA/ICA section, switch ICA on and display the first 3 components 

(default).

� The first component nicely shows the 6-7Hz oscillations and the corresponding map.

� Click  in the Display tabs and fit a moving dipole by selecting Dipole Type: Fixed ICA 

under Dipole Fit in the Source Reconstruction tab.

� Deselect the second and third ICA-component (check-boxes) to fit a single fixed dipole into the 

first ICA-component only. 
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MEG DATA ANALYSIS

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Interictal MEG and MEG Data.

� To use this study: click the Open Study button  next to MEG Data or

double-click MEG Data or 

right-click MEG Data and select Open.
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MODALITY REVIEW 

Remove unwanted channels from the display:

� From the Functional Data menu, select Show Information…. 

� Close the Functional Data Information window.

� In the Options dialog, change the Pagesize to 5s.

� Activate Butterfly Plot (toolbar ).

� Open  and review/change MEG, MEG2, MEG3 colors.

� Disable Butterfly Plot.

� An Elekta MEG file contains MEG (Magnetometers), MEG2 and MEG3 (Gradiometers), EEG, and 

Other channels. Other MEG files (CTF, BTI) only have MEG, EEG, and Other channels.
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MONTAGE SELECTION 

Explore display options for data files with many channels:

� In the Options dialog, select .

� Scroll down to the (light blue) Other channels. EEG061 has been used as the EKG channel.

� In the  dialog, select MEG Elekta Longitudinal Reordered for all three MEG 

groups. 

� Select Longitudinal Referential 2 as the EEG montage. 

� Still in the EEG Montage, select <Edit...> and change EEG064 to EEG061 (for EKG). 

� Press OK and give the changed Montage a name (e.g. Long Ref 2 EKG).

� Referential Montages allow to reorder channels and display a subset of channels.
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FILTERING AND STUDY PARAMETERS

Before reviewing data, adjust filter settings and save study parameters:

� Click the  sign on the right of the  and press  

to insert the Filtering dialog and switch the Filter Type from Off to User Defined (Auto). 

� Adjust the Low Pass filter so that data are filtered from 3 to 30Hz.

� To save these adjustments, open the File menu and select Parameters and Save Study 

Parameters, or press the Save Study Parameters toolbar button .

Accept the suggested filename and press Save.

� Switch to  to display MEG and EEG maps.

� Scroll through the data to review. Use the horizontal scrollbar or right click and select Use 

Mousewheel to Scroll (with or without pressing Shift) from the context menu.

� Click at interesting latencies to display maps.

� A High Pass filter removes low-frequency fluctuations.

A Low Pass filter removes EMG and other high-frequency artifacts.
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COMBINED MEG / EEG DATA ANALYSIS

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Interictal MEG and MEG Spikes.

� To use this study: click the Open Study button  next to MEG Spikes or

double-click MEG Spikes or 

right-click MEG Spikes and select Open.

� The spikes in this study were obtained from the ongoing MEG/EEG (MEG Data) parent study by 

template matching and saved as 25 epochs.
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WAVEFORM AND MAPS DISPLAY

Display Functional Data waveforms and Maps for review:

� Right click in the data display and select Butterfly Plot (or use Alt + B or the  toolbar button) 

to superimpose all channels.

� Use the mouse wheel, or up and down arrow keys or the + and - keys to change the scale.

� Open the  panel and review the Auto / User Defined Interval for noise 

estimation.

� Click the + sign in the displays-tab row and switch to the  display, switch between 

Contours, Maps and both. 

� Use Combine Gradiometers for an alternative display.

� Use the left and right arrow keys to change the display timepoint for the MEG- / EEG-maps.

� Use the horizontal slider to change the spike / epoch (displayed in the lower right corner).

� Make sure the time cursor is set to 0ms.

� These are segments from ongoing MEG / EEG, with the 0ms mark set approximately at the maximum

of a spike, so a time range for noise estimation needs to be explicitly defined.
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SINGLE EQUIVALENT DIPOLE SOURCE RECONSTRUCTIONS AND DIPOLE CLUSTERS

� Click  in the Display tabs and fit a moving a moving dipole by selecting Dipole Type: 

Moving under Dipole Fit in the Source Reconstruction tab.

� Compare measured and forward computed best fit field in the maps display.

� In order to keep the dipole fit results for comparison, click Keep Results  in the tool bar.

� Now switch between MEG and EEG modalities in Channel Groups / Bad Blocks under 

Functional Data parameters, click Keep Results  in the tool bar.

� Reconstruct a dipole cluster from all epochs by clicking  in the Source 

Reconstruction toolbar.

� Finally average all 25 events / epochs by selecting Average in the Epochs-section of the 

Functional Data parameters.
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EPILEPSY SOURCE ANALYSIS

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Interictal Spike and Spike Data.

� To use this study: click the Open Study button  next to Spike Data or

double-click Spike Data or  right-click Spike Data and select Open.

� In this case, study parameters have already been defined.
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WAVEFORM AND MAPS DISPLAY

Display Functional Data waveforms and Maps on top of each other for field propagation detection:

� Right click in the data display and select Butterfly Plot (or use Alt+B or the  toolbar button) to

superimpose all channels.

� Use the mouse wheel, or up and down arrow keys or the + and - keys to change the scale.

� Use Ctrl+drag or Ctrl and Alt + left and right arrow keys to adjust a time range of -10..55 ms.

� Click the + sign in the displays-tab row and switch to the  display, switch 

between Contours, Maps, and both. 

� In the Maps parameter tab select 5 as the number of displayed maps.

� Use the left and right arrow keys to change the display timepoint for the central map.

� This is a segment of ongoing EEG, with the 0ms mark set approximately at the onset of a spike, so a 

time range for noise estimation needs to be explicitly defined.
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DIPOLE FIT 

Compute an equivalent current dipole model for the time range around the peak of the spike:

� Switch to the  display. 

� Open the  panel, change the Dipole Type: to Moving. 

� Switch to a Left View (use the  toolbar button in the 3D View display).

� Open the  panel and use 3 Spherical Shells as the Head Model.

� In 3D View, drag, Shift+drag, and use the mouse wheel to readjust size and perspective.

� In 3D View, double-click one of the dipoles. Dipoles (1 moving) Properties are shown.

� Enable . The three-shell spherical head model is displayed.

� The Moving dipole model computes one dipole solution per latency (sample).
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CREATING A REALISTIC HEAD MODEL

Curry can automatically set up a realistically shaped head model:

� Activate the  display.

� Open the  parameters, switch to Segmentation Results  in the 

lower right view.

� Press Start. The cortical surface and a three shell realistic BEM head model are calculated by 

automated segmentation and tessellation of skin, skull, and brain boundaries.

Yellow outlines on top of the image data slices indicate the relevant boundaries. The 

list in 3D View shows newly available surfaces plus the just created realistic BEM head model.

� The BEM Geometry calculations automatically create the relevant head model surfaces, including 

high-resolution versions of the skin and cortex.

M. Fuchs, R.Drenckhahn, H.-A. Wischmann, M. Wagner, 1998. An Improved Boundary Element 

Method for Realistic Volume-Conductor Modeling, IEEE Trans Biomed Eng 4:980-997.
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REVIEW OF CORTEX AND SKIN MESHES WITH REALISTIC HEAD MODEL

In 3D View, the results of realistic head model setup can be viewed:

� Activate the  display.

� Uncheck  and display .

� In the Cortex (80) 2.5mm Properties below, change the Transparancy to 50%.

� Activate Show Pial Surface.

� Display .

� In the Skin (44) 2.5mm Properties, change the Transparancy to 100%.

� Take a look at the   meshes. 

� There is a discrepancy between dipole locations and brain anatomy due to the spherical head model 

used for the dipole calculations.

� Transparency can be used to visualize interior objects such as the dipoles. Increasing  transparency 

to 100% improves visibility. Not all graphics cards support multiple transparent objects, though.
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DIPOLE FIT IN REALISTIC HEAD MODEL

Dipole calculations can be repeated using the just-created realistic head model.

� Switch to the  display. 

� In the  dialog, change the Head Model to BEM 6/8/9mm. Calculations restart and 

updated dipole results are displayed.

� Enable (and disable) . The BEM realistic head model is displayed.

� Review the results in the  window.

� From the Maps-window icons, switch MGFP  and Residual Deviation  on and review 

expected (broken curve) and explained (solid curve) field deviations.

� Depending on the computer speed and the amount of memory (RAM) the setup and decomposition 

of the BEM matrices can take several minutes. Since the resulting transfer matrix is stored to disk, 

these computations have to be performed only once (as long as sensor and head geometry are not 

changed). 
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CORTICAL CURRENT DENSITY ANALYSIS  

As an alternative source model, calculate the distribution of current flow in the cortical gray matter:

� Expand the  dialog. 

� As the CDR Type, select sLORETA. A 3D grid-based CDR is computed.

� Expand the  dialog. 

� Use the Cortex (80) 2.5mm mesh as the source space.

� Using the 3D View toolbar, switch to Movie Mode  and using the Image Data toolbar 

remove the yellow outlines  from the image data display.

� Use the Cursor left/right keys to change the display timepoint.

� In the CDR (sLORETA) Properties increase the Clip below value to 70%

� CDR methods compute simultaneous activity of all cortical sources.
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SOURCE ANALYSIS AND SEEG TRAJECTORY PLANNING

START CURRY

� Start Curry: double-click the Curry 8 icon    

SCOPE SELECTION

� Make sure Epilepsy scope is selected: From the File menu, select Scope and then Epilepsy.

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Interictal Spikes and EEG Spikes.

� To use this study: click the Open Study button  next to EEG Spikes or

double-click EEG Spikes or  right-click EEG Spikes and select Open.

� The MRI of this patient has not yet been entered in the database.
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SPIKE AVERAGING

Average spike types:

� In the navigation area on the left, display the Events/Epochs panel by clicking the Open Events

 button.

� Below Event Average 1, as the Type, select 1.

� Switch to Event Average 2. As the Type, select 3.

� Selecting an entry in the event list brings up the corresponding page.

� Press the In-Place Averaging button. Events of the same type are averaged. 

� Switch to the FD,Maps display.

� Use the slider below the waveform display to switch between averages.

  

� This file is a collection of previously marked and saved spikes of two different types.
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DIPOLE FIT 

Compute an equivalent current dipole model for the peak of the spike:

� Switch to the All display. 

� Open the Dipole Fit panel, change the Dipole Type: to Moving. 

� Double-click in the 3D View display and check Standard Cortex in the list of Objects.

� Switch to a Left View (use the  toolbar button in the 3D View display).

� Ctrl-click the Head Model panel and check that the Head Model is BEM Precomputed.

� In the 3D View list of Objects, check and un-check Head Model.

� In the Head Model panel, switch to 3 Spherical Shells.

� From the Source Results menu, select Keep Results.

� In the Head Model panel, switch back to BEM Precomputed. The kept dipole is still visible.

� From the Source Results menu, select Remove All Results. The kept dipole disappears.

� In 3D View, drag, Shift+drag, and use the mouse wheel to adjust size and perspective.

� A built-in MRI is used, unless individual image data has been specified.
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ADD INDIVIDUAL MRI 

Add the patient’s individual MRI:

� Switch to the Database parameters.

� Right-click the Interictal Spikes patient and select Insert Image Data Folder... 

� Select Curry 8 Course\Epilepsy\Interictal Spikes\Image Data\MRI and press Insert. 

� Check Autodetect and Load Image Data and press Finish.

� Press Define Landmarks Now.

� For DICOM and NifTi data, all relevant parameters can be autodetected from the image data file 

format. Only landmark locations need to be added manually.
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DEFINE MRI LANDMARKS

Add left ear, right ear, nasion, and inion landmarks for co-registration of MRI and EEG:

� In the 3D preview on the right, click the Nasion location.

� In the lower left, switch to Sagittal View and refine the nasion location.

� Press Next. Click the PAL (left tragus point) location. 

� If necessary, switch to Sagittal View and refine. If tragus is not visible, click the ear canal.

� Press Next. Click the PAR (right tragus point) location. 

� If necessary, switch to Sagittal View and refine. If tragus is not visible, click the ear canal.

� Press Next. Click the Inion location. 

� Switch to Sagittal View and refine.

� Press Finish.

� If a digitizer system is used to obtain real-world EEG electrode locations, the same anatomical 

landmarks should be used for the left and right ear points during digitization and in Image Data 

Parameters.

� After adding image data, all electrodes and source results are automatically co-registered.
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INDIVIDUAL REALISTIC HEAD MODEL CREATION

Curry can automatically set up a realistically shaped head model:

� If necessary, switch to the Image Data display.

� In the lower right view, switch to Segmentation Results.

� Open the BEM/FEM Geometry panel.

� Press Start and Save. This makes sure that results are still available after a re-start.

The skin and a cortical surface as well as a three-shell realistic BEM head model are calculated.

� Yellow outlines are shown for quality control. To delete them, press the Clear Segmentation 

Result  button in the display area or above the image data parameters.

� The BEM Geometry calculations automatically create the relevant head model surfaces, including 

high-resolution versions of the skin and cortex.

M. Fuchs, R.Drenckhahn, H.-A. Wischmann, M. Wagner, 1998. An Improved Boundary Element 

Method for Realistic Volume-Conductor Modeling, IEEE Trans Biomed Eng 4:980-997.

NOTES

89



Curry 8 Course – Epilepsy

CORTEX, SKIN, HEAD MODEL REVIEW

The results of BEM head model creation can now be reviewed:

� Activate the 3D View display.

� Double-click the 3D View display and un-check Standard Cortex in the 3D View list of 

Objects.

� Check Cortex (89) 2.5mm instead. 

� In the Cortex (89) 2.5mm Properties, check Show Pial Surface.

� Right-click in the 3D View display and switch to a Left View. 

� Zoom in using the + key or the mouse wheel.

� In the 3D View list of Objects, check and un-check BEM 6/8/9mm.

� Check Skin (44) 2.5mm. 

� In the Skin (44) 2.5mm Properties, check Depth-dependent transparency.

� The properties of any object in the 3D View display can be displayed by double-clicking.

� Transparency can be used to visualize interior objects. Increasing transparency or depth-dependent 

transparency improves visibility. Some graphics cards do not support multiple transparent objects.
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DIPOLE FIT IN INDIVIDUAL ANATOMY

Source results can now be updated and displayed in individual anatomical context:

� Activate the All display.

� In the Head Model panel, switch to BEM 6/8/9.

Dipole fit is re-calculated based on the individual realistic head model.

� Review the results in the Output area.

� Un-check Skin (44) 2.5mm.

� Check and un-check Head Model

� Drag and rotate the 3D View display.

� In the image data display, zoom in using the + key or the mouse wheel.

� Equivalent current dipoles can be deep to the generating cortex, especially if activated area or cortical

curvature are large. Noise can be an additional factor.
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CORTICAL CURRENT DENSITY ANALYSIS

As an alternative source model, calculate the distribution of current flow in the cortical gray matter:

� Expand the Current Density and the Source Locations panel. 

� As the CDR Type, select sLORETA. A 3D grid-based CDR is computed.

� Use the Cortex (89) 2.5mm mesh as the source space.

� Switch the Source Type to Fixed.

� Change the Extension to 20mm, then to 40mm, then to 60mm.

� In 3D View, click the brightest spot of the current density distribution and review in the image 

data views. 

� Current Density methods compute simultaneous activity of all cortical sources.

� Cortical Current Density, if used together with fixed source orientations and a source extension 

constraint, can visualize the generating cortex. 
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EXPORT SOURCE RESULTS 

Image data enhanced with source results can be exported in DICOM format.

� From the Image Data menu, select Save Image Data As.... 

� Change the Save as type to RGB DICOM Folders. 

� Navigate to the desired save location.

� As the File name, enter the name of the DICOM folder to be created.

� Check Open as New Study and Show Options.

� In the Options window, check Currents and Dipoles. 

� Edit the Series Description, Patient ID, and Accession Number, if required.

� Press Save. Data are saved and a new study opens for quality control.

� Close the study that just opened to continue working in the original study.

� Source results can help identify areas to be targeted by intracranial contacts or by surgery. 
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SEEG TRAJECTORY PLANNING

sEEG trajectories can also be planned in the Curry software.

� Press the + button at the top of the data display and select Localize.

� Below the data display, select 3D View.

� Expand the Grid Geometry panel.

� Make sure that Create or Edit is set to Depth Electrode.

� Check Spacing [mm]. 

� As the Labels, enter A.

� In the MRI, click a location to be used as the end point. Press Ctrl-I.

� In the MRI, click a location to be used as the entry point. Press Ctrl-I.

� In the Grid Geometry panel, press Create.

� At the top of the data display, Ctrl-click Image Data.

� Below the lower right image data view, switch to 3D View.

� As the Number of Contacts, enter 12. Press Adapt.

� If necessary, double-click the current density result in 3D view and in its Properties, change the 

Symbol Size [mm] to 6. 

� The Localize module serves as a general-purpose location editor. 
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SEEG TRAJECTORY PLANNING USING OBLIQUE VIEWS

Oblique views can be used to better define trajectories.

� Right-click the lower left (axial) image data view and select Oblique View and Auto.

� In the info box that appears, click Switch to Oblique View.

� Tilt the lower left image data view using Ctrl+cursor keys.

� Offset the image data view using the mouse wheel or the Shift+cursor up/down keys.

� Click a location to be used as the end point. Press Ctrl-I.

� Click a location to be used as the entry point. Press Ctrl-I.

� In the Grid Geometry panel, as the Labels, enter B.

� Press Create.

� If necessary, change the Number of Contacts and press Adapt.

� Continue entering electrodes.

� Click one of the electrodes in the Localize list in order to re-align the oblique view.

� Click and Shift-click a range of electrodes in the Localize list.

Then, right-click to bring up a context menu.

� Above the Localize panel, press the Save button in order to create a backup.

� Oblique views can be rotated using Ctrl+cursor keys, but in Auto mode they also adapt to any 

contacts that have been selected.
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DEFINING TALAIRACH COORDINATES

Define the landmarks and brain dimensions required for working with Talairach coordinates.

� From the Image Data menu, select Talairach Parameters....

� Enter the AC and PC landmarks, as well as a mid-sagittal (MS) location.

� Press Next and define the brain dimensions, excluding the cerebellum. 

� Pres Finish.

       

    

AC                                                   PC                                                 MS

  

Brain Dimensions

� Talairach coordinates are independent of individual brain dimensions.
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WORKING WITH TALAIRACH COORDINATES

Explore display options that are available with Talairach coordinates:

� From the Coordinates menu, select Talairach. Localize list coordinates change.

� In the 3D View list of Objects, check Talairach Grid.

� In its Properties, change Display Mode to Triple. 

� Place the cursor over the image data views and the 3D view and press the – key repeatedly.

� Above the data display or below the parameter area, click Image Data in order to bring up Image 

Data parameters.

� Expand the Options panel.

� Check Atlas labels.

� Switch Atlas Overlay to All Anatomical Areas and then to All Functional Areas.

� Switch Atlas Overlay to <Off>.

� Un-check Talairach Grid.

� Talairach coordinates can be a means to communicate brain locations and sEEG trajectories.
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CORTEX WITHOUT CEREBELLUM

The cerebellum can be removed from the already created cortex by using Stop Markers:

� In the lower left image data view, right-click and switch Oblique View to Off.

� In the Options panel, deselect Show Results.

� Below the lower right view, switch to Segmentation Result.

� To retrieve the cortex segmentation (“overlay”) which was created up during BEM setup: 

From the Image Data menu, select Overlay, then Import… and double-click Cortex.

� Open the Image Data Segmentation panel.

� From the Result menu button, select Add Exterior to Stop Markers or click the  button.

� Identify an axial slice where the brainstem is isolated after it has bifurcated into the cerebellum.

For this data set, click slice no. 76 from the filmstrip on the left of the image data display.

� Right-click in the lower left (axial) view and select Edit Markers. The Markers panel opens.

� In the axial view, click inside the brainstem. The brainstem is filled with Stop Markers.

� Open the Segmentation panel.

� Use a Lower Threshold of 0. This deactivates the intensity criterion for segmentation.

� Press Start.

� Stop Markers can be defined based on previous segmentation results or entered manually.

NOTES

98



Curry 8 Course – Epilepsy

CORTICAL TRIANGLE MESH WITHOUT CEREBELLUM

Create a cortical triangle mesh based on the segmentation result:

� Open the Create panel. 

� Make sure the Create mode is Triangle Mesh.

� Change Resolution to 2mm.

� Check Prepare Pial Surface.

� Check Label. As the Label, choose Cortex (80) 2.0mm no CB.

� Press Start & Save.

� Switch the lower right display to 3D View.

� Right-click and switch to a left view.

� In the 3D View list of Objects, un-check Source Results.

 

� Prepare Pial Surface makes the pial (brain) surface available for 3D display. This option only makes

sense when creating a triangle mesh based on a cortex segmentation.
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MRI, CT, PET AND AN IMPLANTED ECOG GRID

An implanted grid dataset (ECoG) is loaded. Three image datasets from an epilepsy patient (pre-surgery 

MRI, post-surgery CT, and PET) are co-registered. Grid electrode positions are obtained from CT and 

functional mapping is performed.

START CURRY

� Start Curry: double-click the Curry 8 icon    

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand Intracranial ECoG and ECoG.

� To use this study: click the Open Study button  next to ECoG or

double-click ECoG or right-click ECoG and select Open.
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REVIEW ECOG DATA PARAMETERS

The Functional Data Import wizard opens, since the data are not yet parameterized.

Review and use autodetected data file parameters:

� Press Next.

� Press Finish.

� The ECoG.avg data file contains 64 channels and 684 samples but no sensor locations – these will be

determined later based on the CT images.
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LOAD MRI DATA

Add MRI images in DICOM format, using Curry’s parameter autodetection:

� Display the  parameters.

� In , click .

� Select C:\Curry 8 Course\Epilepsy\Intracranial ECoG\MRI.

� Press the Insert button. The image data import wizard appears.

� Check Autodetect and Load Image Data. 

� Press Finish. Image data are loaded.

� The Autodetect and Load Image Data shortcut is used for image data files in known formats. 

Typically, segmentation thresholds need to be revised and landmarks will still need to be defined, 

as these are not part of the image data (DICOM) header information.
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DEFINE MRI LANDMARKS

Add landmark information, which cannot be autodetected:

� In the  parameters , click .

� The image data wizard appears (again). 

� Uncheck , define landmarks and Talairach coordinates. Finally press 

Finish.
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LOAD CT DATA

Add high-res CT images in DICOM format, using Curry’s parameter autodetection and automatic 

co-registration features:

� In the parameters , click .

� Select C:\Curry 8 Course\Epilepsy\Intracranial ECoG\CT.

� Press the Insert button. The image data import wizard appears.

� Check Autodetect and Load Image Data. 

� Press Finish. Image data are loaded.

� In , click . 

� The image data wizard appears. 

� Press Autodetect…

� Press Start Landmark Autodetection. volume-based co-registration starts (this can take a 

while).

� Press Next, review landmarks and Talairach parameters, and Finish the wizard.

� If landmarks (and Talairach parameters) for the first image data set have been correctly defined, 

landmarks (and Talairach parameters) of subsequent image data sets can be autodetected using 

volume-based co-registration.

WM Wells, P Viola et al., 1996. Multi-modal volume registration by maximization of mutual 

information, Medical Image Analysis 1:35-51
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LOAD PET DATA AND EXPLORE CO-REGISTRATION

Add functional PET images in DICOM format, using the same approach:

� In , click .

� Select C:\Curry 8 Course\Epilepsy\Intracranial ECoG \PET.

� Press the Insert button. The image data import wizard appears.

� Check Autodetect and Load Image Data. Press Finish. 

� In , click . 

� Press Autodetect…. Press Start Landmark Autodetection.

� Press Next, review landmarks and Talairach parameters, and Finish the wizard.

� Click the + in the Display tabs, switch to the  display to see all three co-registered 

image data modalities. Use the cursor to assess co-registration.

� Right-click in MRI and select Show Thresholded, then Image Data 2.

� Change the CT segmentation threshold using the slider next to Segmentation Preview.

� Right-click in MRI and select Show Thresholded, then deselect Image Data 2 and select 

Image Data 3.

� Change the PET segmentation threshold using the slider next to Segmentation Preview.

� Right-click in MRI and select Show Thresholded, then deselect Image Data 3.
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ANALYZE CT DATA

Segment skin and skull from CT data:

� Switch to the  display in order to work with CT data.

� Expand the  dialog.

� As the Seedpoint, use Skin, refine the Lower Threshold to 40.

� Click Start.

� Select  as the fourth view. 

� Right-click in the Segmentation Result view and switch to Front View (or press ).

� Change Segmentation Mode to Thresholding and Lower Threshold to 100 (bone threshold).

� Click Start.

� Right-click in the Segmentation Result view and select Omit Fore Half.

� Switch to Left View (press  from the toolbar).

� Change Segmentation Mode to Dilated Thresholding.

� Click Start.

� Right-click in the Segmentation Result display and deselect Omit Fore Half.

    

� Dilated Thresholding segments any structure whose intensity is above the segmentation threshold, 

no matter how small.
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ANALYZE MRI DATA

Display segmented CT skull overlaid onto MRI and perform automatic segmentation:

� Still looking at CT data, right-click to invoke the context menu, then click Segmentation 

Result and select Export to Image Data 1.

� Change the display to . The CT skull segmentation is overlaid onto the MRI.

� Select  as the fourth view .

� Expand the  dialog.

� Change Create to BEM MEG/ECoG. This will generate a single shell BEM consisting of the 

inner skull boundary (smoothed brain envelope).

� Set Resolution to High and press Start.

� Select  as the fourth view (all electrodes are in one place).

� Double-click in the display to activate  parameters. 

� Check , in the Properties dialog check and uncheck .

� Switch to Left View (press  from the toolbar).

� Segmentation results (and Markers) can be imported to or exported from the first modality (MRI). 
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ISOLATE GRID ELECTRODES FROM CT

This page describes the sequence of actions used to define Stop Markers limiting grid electrode 

definition.

� Switch to the  display in order to work with CT data.

� From the Image Data menu (right-click), select Create Intracranial Electrode Mesh.

� Activate the  display. 

� Switch to a Right View (press ).

� Adjust the display using the mouse and the mouse wheel.

� Click the cortex and change its Transparency to 50%. An 8x8 grid (whose data we have 

already loaded) and several sets of strip electrodes are clearly visible.

� In the 3D scenario, rendered ECoG electrodes can be rotated and individual electrodes can be defined.
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DEFINE 8X8 GRID LOCATIONS IN LOCALIZE

Determine the 8x8 grid electrode positions in Localize:

� Click the + in the display tab and switch to the  display and select  in the 

view lower tabs.

� Switch to a Right View .

� Use Ctrl+drag to rotate and the mouse wheel to zoom. 

(In Localize, clicking adds a location to the list on the left).

� Uncheck  and uncheck .

� Click the grid electrodes: start from the lowermost anterior electrode and work your way up, 

then proceed to the next column, until you have defined all 64 electrodes. Make sure you don’t 

click any of the strip electrodes (if necessary, right-click and select Delete Entry  (last or 

selected one) or Delete All Entries  to revert). 

� When finished entering locations, in , switch from Append to Show.

� Make sure that the large 8 by 8 grid is selected, as there are strip electrodes as well. 
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REFINE GRID AND USE AS ELECTRODE LOCATIONS

Change Localize positions to reflect electrode centers:

� Right-click and select Project All To Nearby Maxima. Select CT. Locations change slightly.

� Right-click and select Import Electrode Labels. Functional Data labels are used.

� Expand  to assign labels.

� Make sure No. Rows, Columns is 8, 8.

� Make sure Labels are G. Press Update. 

(numbering starts with G01)

� Empty Labels field. Press Update. 

(Consecutive numbers starting with 01 are used)

� From the Localize menu, select Save and Use as Digitizer File 

(or press the  button in the Localize toolbar).

� Use the suggested file name, click Save and follow the instructions. 

� Electrodes become visible in the Data Import Wizard. Finish the wizard.

� Electrode locations defined within Curry are used to update the data file. 
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ECOG CORTICAL OVERLAY

Create an overlay of cortex, grid electrodes and voltage maps:

� Click the + button to the right of the display tabs and switch to the  display.

� Un-check Electrode Mesh and Localize, check Cortex (155) 2.5mm. 

� Click the electrodes. Change their Size to 5mm and un-check Show Labels.

� In Functional Data , adjust a timerange from 2660 to 2710ms.

� Switch to  Butterfly Plot and make sure  is switched on. 

� In the 3D View - Electrodes Properties, change the Color to .

� Start a movie by pressing the  toolbar button or Alt+M.

� Check .

� Change Display Mode to Overlaid and Transparency to 50%.

� Start a movie. (if there are display problems, change the cortex transparency to 0%)

� Note the correspondence between cortical structure and maps.
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GRID DATA SOURCE ANALYSIS

Create dipole and CDR source models for the grid data:

� Switch to the  parameters.

� As the Head Model, select BEM MEG/ECoG 4mm.

� As Dipole Fit - Dipole Type, select Moving.

� As Current Density -  CDR Type, choose sLORETA.

� As the Source Locations, use Cortex (155) 2.5mm.

� Toggle Time Range Mode mode (3D View toolbar ), uncheck Electrodes in the 3D-View 

tree.

� For the Maps, change Display Mode to Lines and Transparency to 0%.

� For CDR (sLORETA) change Transparency  to 100%.

� For Dipoles (1 moving) change Scale Mode to Uni and Symbol Size to 10.0mm.

� In the ECoG case, a one-compartment volume conductor model is needed, as the electrodes are 

located directly on the brain. The MEG/ECoG BEM provides such a model.
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ECOG OBLIQUE SLICE IN MRI

Display an oblique slice in the plane of the grid-electrodes in the MR-image data:

� Change the display to .

� Deselect Show Results and click Clear Segmentation Results from the image data pop-up 

toolbar.

� Right-click into the coronal view select Oblique View.

� Select 3D View in the lower right sub-window.

� Click one of the ECoG-electrodes (e.g. electrode 37) in 3D View to adjust the oblique view.

� Use the mouse wheel in the oblique view to move the plane along the plane normal.
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ECOG OBLIQUE SLICE IN CT

Display an oblique slice in the plane of the grid-electrodes in the CT-image data:

� Switch to the  in order to work with the CT-data.

� Right-click into the coronal view select Oblique View.

� Select 3D View in the lower right sub-window.

� Click one of the ECoG-electrodes (e.g. electrode 37) in 3D View to adjust the oblique view.

� Use the mouse wheel in the oblique view to move the plane along the plane normal.
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ECOG OBLIQUE SLICE IN 3D VIEW

Display an oblique slice in 3D View:

� Switch to the .

� Select Cortex (155) 2.5mm in the Objects-list

� From the  Cortex (155) 2.5mm Properties, select Cutplane - Mode: Oblique, - Through: 3D 

Cursor.

� Use Ctrl & Mouse-Wheel to adjust plane offset, left-click to background and drag to rotate the 

scenario.

� Change  Cutplane - Image Data: from 1 to 2 and 3.

� Exit Curry8, don't save results.
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STEREOTACTICALLY IMPLANTED ELECTRODES, MRI AND CT

A dataset from stereotactically implanted electrodes (sEEG) is loaded. Two image datasets from an 

epilepsy patient (pre-surgery MRI and post-surgery CT) are co-registered. Electrode positions are obtained 

from CT and functional mapping overlaid to the cortical surface is performed.

START CURRY

� Start Curry: double-click the Curry 8 icon    

DATABASE SELECTION

� From the Database menu, select Open....

� Change to the C:\Curry 8 Course\Epilepsy folder.

� Select C:\Curry 8 Course\Epilepsy\Curry 8 Epilepsy.cdb.

� Press Open.

� Expand patient Stereo EEG.

� To use this study: click the Open Study button  next to sEEG or

double-click sEEG or right-click sEEG and select Open.

� In this case, study parameters have already been defined.
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REVIEW FUNCTIONAL DATA 

The Functional Data Parameters window does not open, since these data are already 

parameterized. There are study parameters available. Review the Functional Data parameters:

� From the Functional Data menu click Show Information.

The timecursor is set to the begin of a seizure. A few channels have been switched off.

� Expand the Colors panel and change the EEG color to Map (blue..black..red).

� Expand the Montages panel and, from the EEG montages dropdown, select <New...>.

� As the New montage name, use sEEG Grouped and press OK. 

� Press the Add All button and Add Monopolar Traces. Press OK. 

Each electrode is now shown in a different color.

� In the Montages panel, select <New...> again. As the New montage name, use sEEG Bipolar. 

Press OK. Press the Add All button and Add Bipolar Derivation. Press OK.

� This sEEG file contains data from 10 Stereo-EEG electrodes with 12 to 16 contacts each; their 

positions were determined from the CT images.

� Montages can be used to re-order and group electrode contacts, and also for sEEG bipolar derivations.
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REVIEW FUNCTIONAL DATA IN ANATOMICAL CONTEXT

sEEG data should be reviewed in anatomical context:

� In the Display tabs row, click the + sign on the right and select All.

� In 3D View,  the Electrodes are displayed are Spheres and colored according to their voltages.

� Double-click an electrode to review/change the properties. Symbol Shape: Sphere, Size: 3mm,

Color: Map Bright (blue..white..red).

� The cortical surface Cortex (90) segmented from the MRI, can also be displayed.

Change the Transparency to 100%,  check and uncheck Show Pial Surface.

� Right-click the second (coronal) Image Data view and select Oblique View and Auto.

� Click a contact in 3D View. The coronal view now shows accommodate all contacts of that 

electrode. Use the Plus (+)-button to zoom in.

� Oblique views can be used to re-orient image data to accommodate a selected electrode.
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OPEN AND REVIEW MRI AND CT DATA

Pre-implantation MR and post-implantation CT images are already coregistered.

� In the Display tabs row, click the + sign on the right and select ID1, 2 in order to review the  

coregistered MR and CT images.

� Right click into the MRI and select Show Thresholded > Image Data 2.

� In the Segmentation Preview of the CT, right click and select Front View.

� Adjust segmentation threshold in the CT to overlay the skull onto the MRI.

� The previously displayed cortical surface was automatically segmented from the MRI (click 

into the upper image data row). A Finite Element Method (FEM) model of the brain can be 

generated by selecting BEM/FEM Geometry - FEM Stero-EEG and Start.
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ELECTRODES POSITIONS DETERMINED FROM CT DATA

As an example for the electrode localization, the contacts of  the vertical depth electrode are 

distributed along a strait line from the post-implantation CT images.

� In the Display tabs row, click the + sign on the right and select select Localize in order to 

determine positions from the CT images.

� In the lower tabs row, select MIP 2 to display a rotatable Maximum Intensity Projection from 

the CT. The MIP contains depth information, so you can click the bright spots and retrieve their 

3D-coordinates.

� Press Ctrl+drag the MIP image to an angle where the lower and upper contact of the vertical 

depth electrode is best visible.

� Click the lower electrode first and then the upper electrode.

� In the Grid Geometry section, select Create or Edit: Depth Electrodes, set the number of 

contact to 15 and finally press Create. 15 equidistant positions will be determined and put into 

the electrode list.

� Continue with the other needles in the correct order (as connected to the EEG-amplifier).

� Click Save and Use as Digitizer File  in order to apply the positions with the Functional 

Data wizard.
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DISPLAY TALAIRACH GRID IN 3D VIEW

� In the Display tabs row, switch to the .

� Select Cortex (90) 2.5mm, Show Pial Surface, and change Transparency to 50%

� Select Talairach Grid in the Objects-list and set Display Mode to Triple, Color to Dark Sea, 

and use left-click & drag to rotate the scenario.
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CONVERT SEEG-DATA INTO A SINGLE GROUP

The sEEG-data in this case are contained in 10 different groups, each group representing a needle. 

For source reconstruction purposes it may be better to have all electrodes in a single group for 

common referencing. This final exercise shows how to convert the data parameter file into a single 

group. First, all electrode positions are saved into a file and then with the Functional Data wizard, 

the data are regrouped.

� In the Display tabs row, switch to Functional Data.

� Under Channel Groups / Bad Blocks, select groups EEG7 and EEG8.

� Right click and Select All Channels. 

� In the Display tabs row, click + and add Localize.

� Right click and select Import Electrodes from the menu. Make sure 147 electrodes appear in 

the Localize-list.

� Click Save and Use as Digitizer File and use all sensor locations for group 1 (Use and Save).

� On the first page of the Functional Data Import wizard (click Back) change the number of 

Electric Groups from 10 to 1, then click Next and Finish.

� In the Display tabs row, switch to Functional Data.

� Manually deselect bad channels (move mouse over electrode labels to highlight them and click /

shift-click to deselect).

� Finally view the remaining electrodes in 3D View (switch to Butterfly Plot, FD, Maps, 3D 

View, then deselect Localize in 3D View Objects list).

� Exit Curry 8.
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CUSTOM HEAD MODEL CREATION

An MRI dataset from an abnormal brain will be loaded and used to generate a custom head model for source

reconstruction. 

START CURRY

� Start Curry: double-click the Curry 8 icon    

DATABASE SELECTION SELECTION

� From the Database menu, select Open....

� Change to the C:\CURRY 8 Course\Epilepsy folder.

� Expand subject Custom Head Model.

� To use this study: click the Open Study button  next to Abnormal brain or

double-click Abnormal brain or right-click Abnormal brain and select Open.

� The data used in this example is from [1], available at the TCIA platform [2].

[1] Nameeta Shah, Ph.D., et al. (2016). Data from Ivy GAP. The Cancer Imaging Archive. 

[2] Clark K, et al. The Cancer Imaging Archive (TCIA): Maintaining and Operating a Public 

Information Repository, Journal of Digital Imaging, Vol. 26, No. 6, December, 2013, pp 1045-1057.
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AUTOMATIC SEGMENTATION

� Open the dialog BEM/FEM Geometry in the Image Data 1 parameter panel.

� Select Create: FEM Head Model, press Start. Resolution should be set to Medium 4mm on 32 

bit machines.

� Inspect the segmentation result (yellow lines overlaid on the MRI data) through the slices by 

placing your mouse in one of the image views and scrolling; or by using the up, down, left, right 

buttons in your keyboard.

� Note that the brain exhibits a large region of cerebrospinal fluid. It is recommended to take to this 

into account in our head model.
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CUSTOM SEGMENTATION

� Open the Segmentation dialog in the Image Data 1 parameter panel.

� Select Mode: Region Growing, and Segmentation Thresholds (lower, upper) of 0 and 80 

respectively. 

� Locate axial slice number 104 or one close to it in Image Data and position the green Image Data

cursor by clicking anywhere inside the ventricles, i.e. the darker intensity region close to the 

brain’s center.  

� Go back to the Segmentation dialog in the Image Data 1 parameter panel and press Start.

� Open the Morphology dialog in the Image Data 1 parameter panel.

� Select Mode: Closing, Dilation[mm] of 1 and Erosion[mm] of 1. Press Start.

� Go to the Image Data Toolbar by directing your mouse to the top left corner of any Image Data 

views, and press the Create Overlay icon .

� Creating overlays from segmentation allows to incorporate custom compartments in head models.
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CREATE CUSTOM FEM MODEL

� Open the Results parameter panel (if not visible, open via “+ button” ).

� Select the Overlay under FEM Skin in Results > Overlays dialog and change 

its name to Ventricles by typing in the text box under the file’s path (see figure below). 

� Open the FEM Model dialog and press the “Set up a new FEM model” button . The 

Overlays list table is enabled and filled with the overlays we just created in the automatic 

segmentation (FEM Skin, FEM Outer Skull, FEM Inner Skull).

� Add a fourth compartment to the model by selecting the Ventricles overlay from the drop-down 

in the fourth row of the Overlays table. Set the Conductivity to 1.0 S/m (that of cerebrospinal 

fluid).

� Set Sources in: to Overlay 3 (FEM Inner Skull). Press the Create button.

� This model is now ready to be used for source reconstruction. Custom head model creation allows to 

incorporate individualized anatomical characteristics.
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REVIEW MODEL

� Select the 3D View tab in the data display.

� Activate the check-box next to FEM Model 2 in the 3D View > Objects dialog (the leftmost 

parameter panel).

� In FEM Model 2 Properties, set the Color to the User Defined Scale 2 and activate the 

Cutplane in Mode: Coronal. Change the cutplane Offset [mm] to positive or negative values 

(tip: change the Offset value rapidly by placing your mouse in the input value and scrolling).

� Reviewing a FEM model through a cross-sectional cutplane allows to asses how inner boundaries 

between compartments are resolved at a given mesh resolution.

NOTES

127



Curry 8 Course – Epilepsy

CREATE CUSTOM BEM MODEL

Very similar steps as before for the FEM model can be used for a customized BEM model. Instead of

segmentation results (binary overlays), boundary surfaces are required, thus a surface representation 

of the manually segmented ventricles is needed.

AUTOMATIC AND MANUAL SEGMENTATION

� Open the dialog BEM/FEM Geometry in the Image Data 1 parameter panel.

� Select Create: BEM Head Model, press Start. Resolution should be set to High. Boundary 

surfaces for the BEM models are created from the segmented compartments (BEM Skin, BEM 

Outer Skull, BEM Inner Skull).

� From the Image Data menu, select Overlay – Import... Ventricles in order to create a surface 

representation of it.

� In Image Data 1 select Create and create a Triangle Mesh with a Resolution of 2.0mm. Select 

as Label: Ventricles 2.0mm and click Start.

� Open the Results parameter panel (if not visible, open via “+ button” ).

� Open the BEM Model dialog and press the “Set up a new BEM model” 

button. The Surfaces list table is enabled and filled with the surfaces we just

created in the automatic segmentation (BEM Skin, BEM Outer Skull, BEM Inner Skull).

� Add a fourth compartment to the model by selecting the Ventricles surface from the drop-down in

the fourth row of the Surfaces table. Set the Conductivity to 1.0 S/m (that of cerebrospinal fluid).

� Set Sources in: to Surface 3 (BEM Inner Skull). Press the Create button.

� In 3D View select BEM Model 2, right click for Top View projection.

� Close CURRY (do not save any results).

NOTES
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Multimodal NeuroimagingMultimodal Neuroimaging

Michael Wagner, Manfred Fuchs, JMichael Wagner, Manfred Fuchs, Jöörn Kastner, Reyko Tech, Fernando rn Kastner, Reyko Tech, Fernando GascaGasca

Compumedics Neuroscan, Hamburg, GermanyCompumedics Neuroscan, Hamburg, Germany

The Sources of MEG and EEG

++
--

The Sources of MEG and EEG

∆∆BB

The Sources of MEG and EEG

∆∆BB

The Sources of MEG and EEG
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Volume ConductionVolume Conduction Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

EEG: 74 electrodes
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Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

EEG: 74 electrodes

Dipole MapsDipole Maps

•• Single source affects all sensorsSingle source affects all sensors

•• Not necessarily below peak voltage/gradientNot necessarily below peak voltage/gradient

•• Larger map changes for rotationLarger map changes for rotation

•• Smaller map changes for shiftSmaller map changes for shift

•• Large amplitude changes for depth shiftLarge amplitude changes for depth shift

•• Small map changes for source extensionSmall map changes for source extension

Forward and Inverse ProblemForward and Inverse Problem
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Inverse ProblemInverse Problem

•• UnderdeterminedUnderdetermined

–– More unknowns More unknowns 
(brain source activity in time and space) (brain source activity in time and space) 
than than knownsknowns
(sensors x samples data points)(sensors x samples data points)

•• What to do?What to do?

–– Provide additional information / assumptionsProvide additional information / assumptions
about brain source activity in time and spaceabout brain source activity in time and space
(modeling)(modeling)

•• illill--posedposed

–– No unique solutionNo unique solution

Sources: Models of Brain ActivitySources: Models of Brain Activity

•• Activated cortexActivated cortex

•• Point source (dipole)Point source (dipole)

•• Distributed sourcesDistributed sources

(current density)(current density)

•• Source space:Source space:

–– 3D grid3D grid

–– CortexCortex

Finding the SourcesFinding the Sources

•• Dipole fitDipole fit: optimize : optimize 

location, current flowlocation, current flow

few sources (<10)few sources (<10)

•• Distributed sourcesDistributed sources

(current density)(current density): : 

optimize current flowoptimize current flow

all simultaneouslyall simultaneously

Small latency rangeSmall latency range or or 

single time pointsingle time point

(peak, spike, epoch)(peak, spike, epoch)

•• Dipole fitDipole fit: optimize : optimize 

location, current flowlocation, current flow

few sources (<10)few sources (<10)

•• Distributed sourcesDistributed sources

(current density)(current density): : 

optimize current flowoptimize current flow

all simultaneouslyall simultaneously

Finding the SourcesFinding the Sources

Single time pointSingle time point

(for latency range, (for latency range, 

process each sample process each sample 

independently)independently)

Point SourcesPoint Sources

-- aka aka --

Dipole ModelingDipole Modeling

Equivalent Current Dipoles (ECD)Equivalent Current Dipoles (ECD)

Dipole ModelsDipole Models

MovingMoving Rotating/Rotating/ Fixed DipolesFixed Dipoles

RegionalRegional
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Noise Estimation allows to:Noise Estimation allows to:

•• Estimate expected goodnessEstimate expected goodness--ofof--fit fit 
(explain signal not noise, (explain signal not noise, χχ²² criterion)criterion)

•• Compute confidence ellipsoids Compute confidence ellipsoids 
((„„spatial error barsspatial error bars““, per dipole), per dipole)

Noise Signal

Confidence EllipsoidsConfidence Ellipsoids Confidence EllipsoidsConfidence Ellipsoids

Noise Estimation allows to:Noise Estimation allows to:

•• Estimate expected goodnessEstimate expected goodness--ofof--fit fit 
(explain signal not noise, (explain signal not noise, χχ²² criterion)criterion)

•• Compute confidence ellipsoids Compute confidence ellipsoids 
((„„spatial error barsspatial error bars““, per dipole), per dipole)

Distributed SourcesDistributed Sources

-- aka aka --

Current Density Reconstruction (CDR)Current Density Reconstruction (CDR)

Current Density Estimation (CDE)Current Density Estimation (CDE)

Distributed Source ModelingDistributed Source Modeling

Current Source ImagingCurrent Source Imaging

Cortical Source ImagingCortical Source Imaging

……

CDR Vector Field

CDR Map CDR Map (Thresholded)
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CDR MethodsCDR Methods
sLORETA, SNR = 20

sLORETA, SNR = inf.

LORETA, SNR = 20

MNLS, SNR = 20

Pascual-Marqui, Methods & Findings in Experimental & Clinical Pharmacology, 2002

Cortical SourcesCortical Sources

Cortex as Source SpaceCortex as Source Space

•• Cortex segmentationCortex segmentation

•• Triangle mesh: neighborhoodTriangle mesh: neighborhood

•• Surface Surface normalsnormals: current flow: current flow

3D Grid, 
unconstrained

Cortex, 
unconstrained

Cortex, 
normals

Cortex, 
extended

sLORETA CDRsLORETA CDR

Realistic Head ModelsRealistic Head Models

Spherical Head ModelSpherical Head Model
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DipoleDipole in Spherical Head Modelin Spherical Head Model Realistic Head ModelRealistic Head Model

DipoleDipole in Realistic Head Modelin Realistic Head Model SphericalSpherical vs. vs. RealisticRealistic

SphericalSpherical vs. vs. RealisticRealistic Realistic BEM Head ModelRealistic BEM Head Model

•• Boundary Element Boundary Element 
MethodMethod

•• Triangle MeshesTriangle Meshes

•• Isotropic Isotropic 
ConductivitiesConductivities
(one per (one per 
compartment)compartment)
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Realistic FEM Head ModelRealistic FEM Head Model

•• Finite Element Finite Element 
MethodMethod

•• TetrahedraTetrahedra
or Cube or Cube 
MeshesMeshes

•• Anisotropic Anisotropic 
ConductivitiesConductivities
(one per (one per 
element)element)

•• Works withWorks with
sEEGsEEG

M Fuchs, M Wagner et al 2001, Clin Neurophys 112, 1400-1407

74 electrodes, 102 coils, 6240/4160 sources

Spherical vs. RealisticSpherical vs. Realistic

•• Simulate with BEMSimulate with BEM

•• Localize with sphereLocalize with sphere

M Fuchs, M Wagner et al, 1998, IEEE BME  45, 980-997

EEG largest error: 24 mm MEG (tangential only) largest error: 104 mm

Spherical vs. RealisticSpherical vs. Realistic

Electrode Electrode CoregistrationCoregistration ––

how to bring EEG and MRI how to bring EEG and MRI 

togethertogether

Electrode CoElectrode Co--registrationregistration

•• LabelLabel--matchingmatching

–– Labels match template brainLabels match template brain

•• Create 10Create 10--20 system on MRI skin 20 system on MRI skin 

–– If electrodes were applied following 10If electrodes were applied following 10--20 rules20 rules

•• Mark in MRI/CT imagesMark in MRI/CT images

–– Electrodes need to be visible in MRI/CTElectrodes need to be visible in MRI/CT

•• 3D Digitizer3D Digitizer

–– Magnetic or opticalMagnetic or optical

Digitized Electrodes, LandmarksDigitized Electrodes, Landmarks
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Image Data, the same LandmarksImage Data, the same Landmarks Coregistered LandmarksCoregistered Landmarks

NAS

LPA RPA

Coregistered ElectrodesCoregistered Electrodes

Multiple Image Data Multiple Image Data 

CoregistrationCoregistration

MRIMRI

CTCT

PETPET

Image Image CoregistrationCoregistration StrategiesStrategies

•• CriteriaCriteria

–– LandmarkLandmark--based (onebased (one--toto--one)one)

–– SurfaceSurface--based (manybased (many--toto--many)many)

–– VolumeVolume--based (allbased (all--toto--all)all)

•• Transformation (modality errors, Transformation (modality errors, intersubjectintersubject) ) 

–– Linear (rigid, affine)Linear (rigid, affine)

–– NonNon--linear (splines, harmonics)linear (splines, harmonics)

•• OptimizationOptimization

–– Closed form (linear, oneClosed form (linear, one--toto--one)one)

–– Robust optimization (all others)Robust optimization (all others)
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LandmarkLandmark--based, rigidbased, rigid

•• Landmark sets Landmark sets AA and and BB

•• Rigid transformation Rigid transformation T T so that so that AT = BAT = B

T =T = arg min ||arg min ||ATAT –– BB||    with ||    with TTTTT =T = 11

•• Solution: Orthogonal Procrustes problemSolution: Orthogonal Procrustes problem

–– SchSchöönemann 1964nemann 1964

–– DecomposeDecompose AATTBB = U= UΣΣVV (via SVD of(via SVD of AATTBB))

–– Then Then T =T = UVUV

•• Highest accuracy at COGHighest accuracy at COG

•• Which landmarks (or fiducials) to chooseWhich landmarks (or fiducials) to choose

VolumeVolume--based, nonbased, non--linearlinear

•• Volume images Volume images AA and and BB

•• Transformation Transformation T(X) T(X) that maps that maps T(A) T(A) →→ BB

•• Similarity Similarity SS(X(X,,Y) Y) 

–– Joint histogramJoint histogram

–– Mutual Information MI (Wells and Viola 1996)Mutual Information MI (Wells and Viola 1996)

Based on entropy Based on entropy H: SH: S(X(X,,Y)Y) = H(= H(XX)+H()+H(YY))––H(H(XX,,YY))

•• T =T = arg min arg min S(T(A)S(T(A), , B) B) 

•• Solution: robust optimizationSolution: robust optimization

•• Complexity of Complexity of TT vs. speed / success vs. speed / success 

•• No user interaction requiredNo user interaction required

CoregistrationCoregistration: 3 Landmarks, rigid: 3 Landmarks, rigid CoregistrationCoregistration: Mutual Inf., rigid: Mutual Inf., rigid


